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INTRODUCTION TO MATLABver.6/SIMULINKver.4 

Specially Offered Training Course in Machine Control Using Computers, KITA

Instructor:Takami Matsuo, Oita University, matsuo@cc.oita-u.ac.jp
The most part of this text is based on the references [1],[2],[4] and [5].



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
1 

1. Preface 
MATLAB/SIMULINK is a sophisticated mathematics and simulation environment that 
can used to model and analyze dynamic systems. Formerly used mainly by specialists in 
signal processing, numerical analysis and control system design, MATLAB/SIMULINK 
in recent years has achieved widespread and enthusiastic acceptance throughout the 
engineering community. Many engineering schools now require a course based entirely 
or in part on MATLAB early in the curriculum. MATLAB is programmable and has the 
same logical, relational, conditional, and loop structures as other programming 
languages, such as FORTRAN, C, BASIC, Pascal etc. In some schools a MATLAB course 
has replaced the traditional FORTRAN course and MATLAB is the principal 
computational tool used throughout the curriculum. In some technical specialties, such 
as signal processing and control systems, it is the standard software package for 
analysis and design. SIMULINK is an extension of MATLAB that is used to simulate 
dynamic systems. SIMULINK differs from MATLAB in that it has a window-based 
(using block diagrams) graphical user interface. It also adds much functionality to 
MATLAB.  
 
The very first version of MATLAB, written at the University of New Mexico and 
Stanford University in the late 1970s, was intended for use in courses in matrix theory, 
linear algebra, and numerical analysis. Today, MATLAB’s capabilities extended far 
beyond the original “Matrix Laboratory” MATLAB is an easy-to-use interactive system 
and programming language for general scientific and technical computation that 
includes extensive numerical computation and visualization capabilities. Its basic data 
element is a matrix that does not require dimensioning. This allows solution of many 
numeric problems in a fraction of the time it would take to write program in a language 
such as FORTRAN, BASIC, or C. Furthermore, problem solutions are expressed in 
MATLAB almost exactly as they are written mathematically. 
 
Mathematics is the common language of much of science and engineering. Matrices, 
differential equations, arrays of data, plots, and graphics are basic building blocks of 
both applied mathematics and MATLAB. It is the underlying mathematical base that 
makes MATLAB accessible and powerful. MATLAB’s compactness is a big advantage. 
For example, you can solve a set of many linear algebraic equations with just three lines 
of code, a feat that is impossible with traditional programming languages. MATLAB is 
also extensible; currently more than 20 “toolboxes” in various application areas can be 
used with MATLAB to add new commands and capabilities. 
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MATLAB is maintained and sold by The MathWorks, Inc., of Natick, Massachusetts, 
and available for Microsoft Windows and for other operating systems. It is compatible 
across all these platforms, which enables us to share their programs, insights, and 
ideas. 
 
This text is intended as a stand-alone introduction to MATLAB version 6/SIMULINK 
version 4. The most part of this text is based on the references [1],[2], and [4]. 
 

2. An Overview of MATLAB 
2.1 MATLAB Product Family 

See http://www.mathworks.com/products/prodoverview.shtml. 
● MATLAB core module for basic mathematical calculation 
● Application Development Tools include  
・ MATLAB Compiler 
・ C/C++ Math and Graphics Libraries 
・ MATLAB Web Server 
・ MATLAB Runtime Server. 

● Toolboxes are collections of highly-optimized, application-specific functions that 
extend MATLAB and Simulink. There are many different toolboxes available that 
extend the basic functions of MATLAB into different application areas, e.g., 
Optimization, Signal Processing, Financial, Statistics, Spline, Neural Network, 
Financial Time Series, Partial Differential Equation, Financial Derivative, Wavelet, 
Image Processing, Filter Design, System Identification, Control System, 
Mu-Analysis & Synthesis, Fuzzy Logic, LMI Control, Robust Control, Model 
Predictive Control, Communications, GA etc. 

● Data Acquisition and Access Tools provide straightforward access to data from 
external devices and other software packages. From controlling and communicating 
with data acquisition devices and instruments to database connectivity and 
interfacing with programs such as Microsoft Excel, these products allow you to 
easily get your data into MATLAB, e.g., 
・ MEX : interface for C,C++,FORTRAN codes 
・ DDE (Dynamic Data Exchange) for Windows 
・ Active X 
・ Java. 

● MATLAB Student Version makes MATLAB, Simulink, and the Symbolic/Extended 
Math Toolbox available at a low cost to students worldwide.  
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● Simulink is a simulation and prototyping environment for modeling, simulating, 
and analyzing real-world, dynamic systems. Simulink provides a block diagram 
interface that is built on the core MATLAB numeric, graphics, and programming 
functionality. 

● Stateflow is a graphical simulation environment for modeling and designing 
event-driven systems. Stateflow provides Simulink users with an elegant solution 
for designing the control or protocol logic found in embedded systems. 

● Blocksets are collections of application-specific blocks that support multiple design 
areas, including electrical power-system modeling, digital signal processing, 
fixed-point algorithm development, and more. These blocks can be incorporated 
directly into your Simulink models, e.g., 
Real-Time Windows Target, Fixed Point Blockset, DSP Blockset, Communication 
Blockset, Simulink Performance Tools, Power System Blockset, Nonlinear Control 
Design Blockset. 

● Code Generation Tools : Real-Time Workshop and Stateflow Coder generate 
customizable C code directly from your Simulink and Stateflow diagrams for rapid 
prototyping, hardware-in-the-loop simulations, and desktop rapid simulation. 
Extension products generate efficient C code for embedded systems applications and 
Ada 95 and Ada 83 code. 

● MathWorks Partner Products : Over 300 third-party hardware and software 
products are compatible with the MathWorks tools. These partner offerings include 
toolboxes, blocksets, Real-Time Workshop targets, and interfaces to other 
commercial products, as well as training, and consulting services. 

2.2 What you can do via MATLAB 

● Numerical computation 

・ Based on reliable package(LINPACK,EISPACK). 
・ Matrix oriented data structure and operations. 

● Programing language 

・Interpreter system + Script file (M-File). 
● Graphics 

・ Two dimensional, Three dimensional, Image, Movie animation 
● Strong Libraries (Toolboxes) 

・ Signal processing toolbox 
・ Control system toolbox 
・ Symbolic math toolbox 
・ And others for each engineering. 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
4 

2.3 MATLAB Interactive Sessions 

We show how to start MATLAB, how to make some basic calculations, and how to exit 
MATLAB. 
● Starting MATLAB 

To start MATLAB on a Microsoft Windows system, double-click on the MATLAB icon. 
You will then see the MATLAB desktop. 
・ Command window 

Use command window to communicate with the MATLAB program, by typing 
instructions of various types called commands, functions, and statements. 

MATLAB displays the command prompt >> to indicate that it is ready to 
receive instructions. The prompt in the Student Edition looks like EDU>>. 

・ Command History window 
shows all the previous keystrokes you entered in the Command Window. It is 

useful for keeping track of what you typed. 
・ Launch Pad window 

lists the toolboxes and other MATLAB-related programs such as SIMULINK, 
that are installed on your computer. This window is much like a file manager 
window; you can use it to access files and folders containing these tools. For 
example, clicking on the + sign next to the MATLAB icon will produce a list of 
files and folders dealing with various topics. 

・ Toolbar 
 a row if menu names and a row of icons 

・ Box showing the directory where MATLAB looks for and saves files 
You can alter the appearance of the Desktop if you wish. For example, to eliminate the 
Launch Pad window, just click on its Close Window button (X) in its upper right-hand 
corner. To undock, or separate the Launch Pad window form Desktop, click on the 
button containing an arrow. To restore the default configuration, click on the View 
menu, then click on Desktop Layout, and select Default. 
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● Entering Commands and Expressions 

Type a MATLAB command after the command prompt EDU>>. 
If we want to use as the English mode, type  

 

◇Simple examples 
Make sure the cursor is at the prompt in the Command window. To divide 2 by 5, type 
2/5 and press Enter (the symbol / is the MATLAB symbol for division). Your entry and the 
MATLAB response look like the following on the screen (we call this interaction 
between you and MATLAB an interactive session, or simply a session). 

 

 

 

 
MATLAB uses high precision (double precision) for its computations, but by default it 
usually displays its results using four decimal places. This is called the short format. 
This default can be changed by using the format command. MATLAB uses the notation 
e to represent exponentiation to a power of 10, e.g., MATLAB displays the number 2.5
×102 as 2.5e+02. 
MATLAB has assigned the answer to a variable called ans, which is an abbreviation for 
answer. A variable in MATLAB is a symbol used to contain a value. You can use the 
variable ans for further calculations, e.g., 

  EDU>> 0/0 
Warning: Divided by zero 

ans = 

2.0000 

EDU>> 2/5 
ans =  

0.4000 

EDU>>  set(0,’Language’,’English’) 

Command window 
Launch pad 

MATLAB Command 

Command 

Box showing directory 

System control tool bar 
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You can use variables to write mathematical expressions. You can assign the result to a 
variable of your own choosing, say r, as follows: 

 

 

 
If you type r at the prompt, you will see 

 

 

 
You can use this variable in further calculations, e.g., 

 

 

 
When we do not specify a variable name for a result, MATLAB uses the symbol ans as a 
temporary variable containing the most recent answer.  
● Data Structures 

・ The basic element in MATLAB is a double-precision complex matrix. 
・ This representation is quite general and includes real and complex vectors and 

scalars. It indirectly includes polynomials and transfer functions 
● Numbers and Arithmetic Expressions 

Conventional decimal notation, with optional decimal point and leading minus sign, is 
used for numbers. A power-of-ten scale factor can be included as a suffix, e.g., 
   3  -99   0.0001   9.96   1.6e-10   -5e20  etc. 
On computers using IEEE floating point arithmetic, the relative accuracy of numbers is 
eps. The range is roughly 10-308 to 10308. 
 Expressions can be built up using the usual arithmetic operators and precedence 

rules: 
MATLAB Form Operation MATLAB Form Operation 

a^b Exponentiation ab a¥b Left division b/a 
a*b Multiplication ab a+b Addition a+b 
a/b Right division a/b a-b Subtraction a-b 

¥ is the japanese maney character that is equivalent to the backslash(＼) in Engilish mode OS. 

 Most ordinary elementary mathematical functions found on a good scientific 
calculator are built-in functions, e.g., abs, sqrt, log, and sin. One of these is the 
square root function, sqrt. More can be added easily with M-files. A pair of 
parentheses is used after the function’s name to enclose the value – called the 

EDU>> s=10*r 
s =  

5 

EDU>> r 
r =  

0.5000 

EDU>> r=5/10 
r =  

0.5000 
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function’s argument – that is operated on by the function. For example, to compute 
the square root of 5, you type sqrt(5). 
 A number of built-in functions simply return commonly used special values. 
・ pi returns π, precalculated by the program as 4*atan(1) , e.g., 

 

 

 
・ Inf stands for infinity, e.g., 

 

 

 

 
・ NaN stands for “Not a Number”, e.g., 

 

 

 

 

 

 

 
● Complex Numbers 

Complex numbers are allowed in all operations and functions in MATLAB. Complex 
numbers are entered using the special functions i and j, e.g.,  
  

 

 

 

 

 

 

 

 

 

 

 
 

EDU>> a = 1+2j 
a =  

1.0000 + 2.0000i 

EDU>> b = -1+j 
b =  

 -1.0000 + 1.0000i 

EDU>> c = a+b 
c =  

 0 + 3.0000i 

EDU>> exp(c) 
ans = 

 -0.9900+0.1411i 

EDU>> 0/0 
Warning: Divided by zero 

ans = 

   NaN 

EDU>> Inf/Inf 
ans =  

   NaN 

EDU>> 1/0 
Warning: Divided by zero 

ans = 

   Inf 

EDU>> pi 
ans =  

   3.1416 
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● Output Format 

The numerical display format can be controlled using the format command. The format 
command affects only how data are displayed, not how they are computed or saved 
(MATLAB performs all computation in double precision), e.g., 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Basic Calculations (Scalar) 

 
 
 
 
 
 
 

・Addition 

 EDU>>1+2 
 ans = 

        3 

・Subtraction 

 EDU>>2e2-1.5 
 ans = 

 198.5000 

・Multiplication 

 EDU>>10.5*3 
 ans = 

 31.5000 

・Division(1) 

 EDU>>10/3 
 ans = 

 3.3333 

 EDU>>format long 
 EDU>>10/3 
 ans = 

    3.33333333333333 

EDU>> a = 1/3 
 a =  

0. 3333 

EDU>> format short e 
EDU>> a 
a =  

   3.3333e-001 

EDU>> format long 
EDU>> a 
a =  

   0.33333333333333 

EDU>> format long e 
EDU>> a 
a =  

   3.333333333333333e-001 
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● Workspace Information 

*  Workspace:memory space for MATLAB variables. 
* Getting workspace information, type as follows: 

  
 
 
 
 
 
 
 
 

 

 Variables are declared implicitly. 
 Variables are stored as matrices of the 

elements in double preision. 
 Variable name must start with a letter,

followed by letters, under score and 
numbers. 

EDU>> who 
Your variables are: 

a  b  c   

EDU>> whos 
  Name      Size         Bytes  Class 

  a         1x1              8  double array 

  b         1x1              8  double array 

  c         1x1              8  double array 

Grand total is 3 elements using 24 bytes 

・Setting  variables 

 EDU>> a=2 
 a = 

        2 

 EDU>> b=10.5 
 b = 

 1.0500e+001 

 EDU>> c=a*b 
 c = 

        21 

・Exponential 

 EDU>>2^3 
 ans = 

        8 

・Mixed 

 EDU>>2*(2+3)-3/5 
 ans = 

  9.4000e+000 

 

・Division(2) 

 EDU>>format short e 
 EDU>> 10/3 
 ans = 

   3.3333e+000 

・Division(3) 

 EDU>>10¥3 
 ans = 

   3.0000e-001 
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● Simple Math( summary : special variables) 

Command Description 
ans The default variable name used for result 
pi Circular constant (1) 
eps Machine epsilon (2) 
inf Stands for infinity, e.g. 1/0 
NaN  and  nan Stands for Not-a-number, e.g. 0/0 
i  and  j Imaginary unit, e.g. i = j = sqrt(-1) 

(1) The ratio of the circumference of a circle to its diameter , 3.141592…(2) The smallest 

number such that,  when added to one creates a number greater than one on the computer 

{eps=1.0; while(1.0+eps/2.0>1.0){eps/=2.0;}}(in C langage) 

● Simple Math( summary : comments and punctuation) 

Notation Decription 
% Mark of comment 
<espression> ; Printing of the result is omitted. 

 
 

 
 
 
 
 
 
● Simple Math( summary : complex numbers) 

Command Description 
abs Absolute value or magnitude of complex number 
angle Phase angle 
complex Convert (real,imag) to complex number 
conj Conjugate number 
imag Imaginary part 
real Real part 
unwrap Unwrap phase angle 
isreal Check real or complex number 
cplxpair Arranging of array 

 

EDU>> % Example of simple calculatios 
EDU>> taro = 162; 
EDU>> hanako = 145; 
EDU>> average = (taro+hanako)/2 
average = 

  153.5000 
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● Scientific Features( summary : mathematical functions/trigonometric) 

Command Description Command Description 
sin Sine sec Secant 
sinh Hyperbolic sine sech Hyperbolic secant 
asin Arc sine asec Arc secant 
asinh Hyperbolic arc sine asech Hyperbolic arc secant 
cos Cosine csc Cosecant 
cosh Hyperbolic cosine csch Hyperbolic cosecant 
acos Arc cosine tanh Hyperbolic tangent 
acosh Hyperbolic arc cosine acsc Arc cosecant 
tan Tangent acsch Hyperbolic arc cosecant 
tanh Hyperbolic tangent cot Cotangent 
atan Arc tangent coth Hyperbolic cotangent 
atan2 Four quadrant atan acot Arc cotangent 
atanh Hyperbolic arc tangent acoth Hyperblic arc cotangent 
● Scientific Features( summary : mathematical functions/basic functions) 

Command Description Command Description 
exp Exponential fix Rounding toward zero 
log Logarithm floor Rounding toward minus infinity 
log10 Logarithm (base 10) ceil Rounding toward infinity 
log2 Logarithm (base 2) round Rounding to the nearest integer 
pow2 Power (base 2) mod Modular 
sqrt Square root rem Remainder after division 
nextpow2 (1) sign Signature function 
 

EDU>> abs(a) 
ans = 

    2.2361 

EDU>> angle(b) 
ans = 

    0.9828 

EDU>> real(a) 
ans = 

     1 

EDU>> a=1+2i 
a = 

   1.0000 + 2.0000i 

EDU>> b=i*3+2 
b = 

   2.0000 + 3.0000i 

EDU>> a*b 
ans = 

  -4.0000 + 7.0000i 
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● Commands for Managing the Work Session 

Command Description 
clc Clears the Command window. 
clear Removes all variables from memory. 
clear var1 var2 Removes the variables var1 and var2 form memory. 
exist(‘name’) Determines if a file or varibale exists having the name ‘name’. 
quit Stops MATLAB. 
who Lists the variables currently in memory. 
whos Lists the current variables ans sizes, and indicates if they have 

imaginary parts. 
: Colon generates an array having regularly spaced elements. 
, Comma separates elements of an array. 
; Semicolon suppresses screen printing; also denotes a new row in 

an array. 
… Ellipsis continues a line. 
2.4 Menus and the Toolbar 

Desktop manages the Command window and the other MATLAB tools. Besides the 
Command window, the default Desktop includes two other windows, the Command 
History and Launch Pad windows. Other windows appear in a MATLAB session, 
depending on what you do. For example, 
・ a graphics window containing a plot appears when you use the plotting 

functions; 
・ an editor window, called the Editor/Debugger, appears for use in creating 

program files. 
・ The Workspace Browser enables you to examine the variables that MATLAB is 

using. 
● The Desktop Menus 

Most of your interaction will be in the Command window. When the command window is 
active, the default MATLAB 6 Desktop has six menus: File, Edit, View, Web, 
Window, and Help. Note that these menus change depending on what window is 
active. Every item on a menu can be selected with the menu open either by clicking on 
the item or by typing its underlines letter. 
*The File Menu in MATLAB 6 

・ New opens a dialog box that allows you to create a new program file, called an 
M-file, using a text editor called the Editor/Debugger, or a new Figure or Model 
file. 
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・ Open… opens a dialog box that allows you to select a file for editing. 
・ Close Command Window closes the Command window. 
・ Import Data… starts the Import Wizard, which enables you to import data 

easily. 
・ Save Workspace As… opens a dialog box that enables you to save a file. 
・ Set Path… opens a dialog box that enables you to set the MATLAB search path. 
・ Preferences… opens a dialog box that enables you to set preferences for such 

items as fonts, colors, tab spacing, and so forth. 
・ Print… opens a dialog box that enables you to print all of the Command 

window. 
・ Print Selection… opens a dialog box that enables you to print selected portions 

of the Command window. 
・ File List contains a list of previously used files, in order of most recently used. 
・ Exit MATLAB closed MATLAB. 

*The Edit Menu in MATLAB 6 

・ Undo reverses the previous editing operation. 
・ Redo reverses the previous Undo operation. 
・ Cut removes the selected text and stores it for pasting later. 
・ Copy copies the selected text for pasting later, without removing it. 
・ Paste inserts any text on the clipboard at the current location of the cursor. 
・ Paste Special… insets the contents of the clipboard into the workspace as one 

or more variables. 
・ Select All highlights all text in the Command window. 
・ Delete clears the variable highlighted in the Workspace Browser. 
・ Clear Command Window removes all text from the Command window. 
・ Clear Command History removes all text from the Command History window. 
・ Clear Workspace removes the values of all variables from the workspace. 

*The View Menu in MATLAB 6 

Use the View menu to control the configuration of the Desktop, to access the current 
directory, to access the help system, and to display the Workspace Browser. 
*The Web Menu in MATLAB 6 

Use the Web menu to access The MathWorks support site, which includes the main web 
site, online technical support, information about new products, and updates. 
*The Window Menu in MATLAB 6 

The Window menu has one or more items depending on what you have done thus far in 
your session. Click on the name of a window that appears on the menu to open it. 
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2.5 An Example (scalar calculation : coordinate transform) 

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
2.6 Saving the Workspace 

The Workspace may be saved for later use by typing 
 

 

This saves all variables in a file on disk named matlab.mat. The next time MATLAB is 
invoked, the workspace may be restored from matlab.mat by executing 
 
 
Save and load may be used with other file names, or to save only selected variables. 
The command save temp stores the current variables in the file named temp.mat. 
The command 
 
 
Saves only variable X, while 
 
 
saves X,Y, and Z. 
load temp retrieves all the variables from the file named temp.mat. load and save 
are also capable of importing and exporting ASCII data files. 

Real 

Im 

0 

a+bi b

a

Θ 

M 

(a,b)→(M,Θ) 

EDU>> i = sqrt(-1); 

EDU>> a = 1; b=1; 

EDU>> x = a + b*i; 

EDU>> M = abs(x); 

EDU>> th_rad =angle(x);  

EDU>> th_deg =angle(x)*180/pi; 

(M,Θ)→(a,b) 

EDU>> i = sqrt(-1); 

EDU>> a = M*cos(th_rad); 

EDU>> b = M*sin(th_rad); 

EDU>> x = a + b*i;  

EDU>> save 

EDU>> load 

EDU>> save temp X 

EDU>> save temp X Y Z 
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●Examples 

1) Create a folder for MATLABprogram on Windows OS. 
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2) Set the MATLAB current directory. 
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3) Calculate and saving data. 
 
 
 
 
 
 
 
 
 
 
 
 
 Save only variable “a”. 

 
 
 Save two variables “a” and “b”. 

 
 

EDU>>a=1 

EDU>>b=2 

EDU>>save 

EDU>>who 

EDU>>clear 

EDU>>who 

EDU>>dir 

EDU>>load 

EDU>>who 

EDU>> save  temp  a 

EDU>> save  temp2  a  b 
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 Load the specified mat-file. 
 
 
2.7 Script Files and the Editor/Debugger 

You can perform operations in MATLAB in two ways: 
1) In the interactive mode, in which all commands are entered directly in the 

Command window, or 
2) By running a MATLAB program stored in script file. This type of file contains 

MATLAB commands, so running it is equivalent to typing all the commands – one at 
a time – at the Command window prompt. You can run the file by typing its name at 
the Command window prompt. 

Using the interactive mode is similar to using a calculator, but is convenient only for 
simpler problems. When the problem requires many commands, a repeated set of 
commands, or has arrays with many elements, the interactive mode is inconvenient.  
 
MATLAB allows you to write your own programs to avoid this difficulty. You write and 
save MATLAB programs in M-files, which have the extension .m; e.g., exapmle.m. 
You can use the Editor/Debugger built into MATLAB to create M-files. The program (as 
an ASCII text file) must reside in a folder (directory) that is in MATLAB’s path. There 
are two types of M-files: 
・ Script M-files : A script M-file contains a sequence of MATLAB commands, and 

is useful when you need to use many commands or arrays with many elements. 
You execute a script file at the Command window prompt by typing its name 
without the extension .m. Script M-files may contain any valid MATLAB 
commands or functions, including user-written functions. The variables created 
by a script M-file are global variables. 

・ Function M-files : A function M-file is useful when you need to repeat the 
operation of a set of commands. You can create your own function M-files. 

● Script M-files (summary) 

・ Long sentences of MATLAB commands can be replaced in a script M-files. 
・ To execute a script M-file, simply type its file name (without its extension) at 

the prompt. 
・ Script M-files operate globally on the data in the workspace. 

 
 
 

EDU>> load  temp 

Save as “scaadd.m” 

 
c = a+b 

EDU>>a=1 
EDU>>b=1 
EDU>>scaadd 
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● Function M-files (summary) 

Main differences between script M-files and function M-files are 
・ Function M-files allow parameter passing by values. 
・ They use local variables and do not operate globally on the workspace. 
・ The first line of a function M-file must contain the word “function”. 

 
 
 
 
 
 
● Creating and Using a Script M-files 

To create a new M-file, you can use the Editor window. You can open the Editor window 
using the Command window or the Control Tool bar. 
・ How to open the Editor window with prompt 

1) Move to working directory (folder). 
2) Confirm the current directory (folder). 
3) Open the editor window to create file_name.m. 

 
 
 
 
・ How to open the Editor window with Control Tool bar 

1) Set the current directory (folder). 
2) Select New from the File menu, then select M-file. 

 
 
 
 
 
 
 
 
 
 
 

Save as “scalaradd.m” 

 
function c=scalaradd(a,b) 
c = a+b; 

EDU>>scalaradd(2,3) 
ans = 

     5 

These names must be same. 

EDU>> cd  working_directory 

EDU>> pwd; 

EDU>> edit  file_name

Set current  

directory 

File → New → M-file 
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● How to Use the Editor Window 

In the Editor/Debugger window, 
1) Enter MATLAB statements. 
2) When finished, select Save from the File menu. 

 

 
● How to execute M-file 

Once the file has been saved, you can execute a script M-file by command base or by 
editor base. 
・ Command base 

Enter the file name (without its extension “.m”) on the command window. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter MATLAB statements 

Save script file  

with extension “.m” 

EDU>> example1 
D = 

    20 

th_deg = 

    30 

h = 

    1.5000 

H = 

   13.0470 

% Example1.m script file for height of

tree 

format short 

format compact 

D = 20 

th_deg = 30 

h = 1.5 

H = h + D * tan( th_deg / 180 * pi )

example1.m command window 

call 

message
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・ Editor base 

 
 
 
 
 
 
 
 
 
 
 
 
● Effective Use of Script M-Files 

1) The name of a script file must follow the MATLAB convention for naming 
variables; that is, the name must begin with a letter, and may include digits and 
the underscore character, up to 31 characters. 

2) Recall that typing a variable’s name at the Command window prompt causes 
MATLAB to display the value of that variable. Thus, do not give a script file the 
same name as a variable it computes because MATLAB will not be able to 
execute that script file more than once, unless you clear the variable. 

3) Do not give a script file the same name as a MATLAB command or function. You 
can check to see if a command, function or file name already exists by using the 
exist command. For example,  

・ To see if a variable example1 already exists, type exist (‘example1’); this 
will return a 0 if the variable does not exist, and a 1 if it does. 

・ To see if an M-file example1.m already exists, type 
exist(‘example1.m’,’file’) before creating the file; this will return a 0 if the 
file does not exist, and a 2 if it does. 

・ To see if a built-in function example1 already exists, type 
exist(‘example1’,’builtin’) before creating the file; this will return a 0 if the 
built-in function does not exist, and a 5 if it does. 

4) As in interactive mode, all variables created by a script M-file are global 
variables, which means that their values are available in the basic workspace. 
You can type who to see what variables are present. 

5) Variables created by a function M-file are local to that function, which means 

Select “Debug”à”save and execute”
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that their values are not available outside the function. All the variables in a 
script M-file are global. Thus, if you do not need to have access to all the 
variables in a script M-file, consider using a function M-file instead. This will 
avoid “cluttering” the workspace with variable names, and will reduce memory 
requirements. 

● Effective Use of the Command and Editor/Debugger Windows 

1) You can use the mouse to resize and move windows so they can be viewed 
simultaneously. Or you can dock the Editor/Debugger window inside the 
Desktop by selecting Dock from the view menu of the Editor/Debugger. To 
activate a window, click on it. 

2) If the Editor/Debugger is not docked, use the Alt-Tab key combination to 
switch back and forth quickly between the Editor/Debugger window and the 
Command window. In the Command window, use the up-arrow key (↑) to 
retrieve the previously typed script file name, and press Enter to execute the 
script M-file. This technique allows you to check and correct your program 
quickly. After making changes in the script M-file, be sure to save it before 
switching to the Command window. 

3) You can use the Editor/Debugger as a basic word processor to write a short 
report that includes your script M-file, results, and discussion. First use the 
mouse to highlight the results shown in the Command window, then copy ans 

paste them to the Editor/Debugger window above and below your script M-file 
(use Copy and Paste on the Edit menu). Then, to save space, delete any extra 
blank lines, and perhaps the prompt symbol. Type your name and any other 
required information, add any discussion you wish, and print the report from the 
Editor/Debugger window, or save it and import it into the wordprocessor of your 
choice (change the file name or its extension if you intended to use the script 
M-file again). 

● Debugging Script M-files 

Debugging a program is the process of finding and removing the “bugs”, or errors, in a 
program.  
・Error categories 

1) Syntax errors such as omitting a parenthesis or comma, or spelling a 
command name incorrectly. MATLAB usually detects the more obvious 
errors and displays a message describing the error and its location. 

2) Errors due to an incorrect mathematical procedure, called runtime errors. 
They do not necessarily occur every time the program is executed; their 
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occurrence often depends on the particular input data. A common example 
is division by zero. 

MATLAB error messages usually allow you to find syntax errors. However, runtime 
errors are more difficult to locate. To locate such an error, try the following: 

1) Always test your program with a simple version of the problem, whose 
answers can be checked by hand calculations. 

2) Display any intermediate calculations by removing semicolons at the end of 
statements. 

3) Use the debugging features of the Editor/Debugger. 
2.8 M-file Programming Utilities 

Command Description 
disp(ans) Display results without variable name. 
echo Control of echoing of script M-file (on/off) 
input Prompt user for input 
keyboard Give control to keyboard. 

Type ‘return’ to quit. 
pause Pause until press any key. 
Pause(n) Pause for n seconds. 
waitforbuttonpress Pause until press any key or mouse. 

2.9 Script M-file Example 

1) Type the following codes in the Editor/Debugger window. 
 
 
 
 
 
 
 
2) Save as arith.m in your directory (folder). 
3) Call the M-file form the Command window. 
 
 

a = input(‘a=’) 

b = input(‘b=’) 

c = a+b 

d = a-b 

e = a*b 

f = a/b 

EDU>> arith 
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4) Or Execute via the Editor/Debugger window. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type the codes. Save the file. 

Execute the M-file via command 

Execute the M-file via Editor/Debugger
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2.10 The MATLAB Help System 

To explore the more advanced features of MATLAB, you will need to know how to use 
effectively the MATLAB Help System. 
1) Help Browser : This graphical user interface helps you find information and view 

online documentation for your MathWorks products. 
2) Help Functions : The functions help, lookfor, and doc can be used to display 

syntax information for a specified function. 
3) Other Resources : For additional help, you can run demos, contact technical 

support, search documentation for other MathWorks products, view a list of other 
books, and participate in a newsgroup. 

● The Help Browser 

The Help Browser enables you to search and view documentation for MATLAB and your 
other MathWorks products. To open the Help Browser, select MATLAB Help from the 
Help menu, or click the question mark button in the toolbar. The Help Browser 
contains two window “panes”: the Help Navigator pane on the left and the Display pane 
on the right. The Help Navigator contains four tabs: 
・ Contents : a contents listing tab, 
・ Index : a global index tab, 
・ Search : a search tab having a find function and full search features, and 
・ Favorites : a bookmarking tab to mark favorite pages. 
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● Help Functions 

Three MATLAB functions can be used for accessing online information about MATLAB 
functions. 
・ help funcname  Displays in the Command window a description of the 

specified function funcname, e.g.,   
 
 
 
 
・ lookfor topic  Displays in the Command window a brief description for all 

functions whose description includes the specified keyword topic. 
・ doc funcname  Opens the Help Browser to the reference page for the 

specified function funcname, providing a description, additional remarks, and 
examples. 

● MATLAB Demos 

Select Demo in Help menu or type demo in command prompt. 

 
 

EDU>> help  eig 
 

EIG  Eigenvalues and eigenvectors. 

……
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3. Array and Matrix Operations 
One of the strengths of MATLAB is the capability to handle collections of numbers, 
called arrays. For example, when we add two arrays A and B by typing the single 
commands C = A + B, MATLAB actually adds all the corresponding numbers in A and 
B to produce C. In most other programming languages, this operation requires more 
than one command. The array-handling feature means that MATLAB programs can be 
very short.  
 
MATLAB contains no dimension statements or type declarations. Storage is allocated 
automatically, up to the amount available on any particular computer. The easiest 
method of entering arrays is to use an explicit list. The explicit list of elements is 
separated by blanks or commas, is surrounded by brackets, [ and ], and uses the 
semicolon ; to indicate the end of the row. 
● Array types (What is array?) 

・ Scalar 

 
 
・ One dimensional array (row vector) 

 
 
・ One dimensional array (column vector) 

 
 
 
 
 
 
 
 
・ Two dimensional array (matrix) 

 
 
 
 
 
 

Single value 
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● How to create row vectors 

To create a row vector, you can separate the elements by commas or spaces, e.g., 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
● How to create column vectors 

To create a column vector, separate the elements by semicolons, alternatively, type a left 
bracket [ and the first element, press Enter, type the second element, press Enter, and 
so on until you type the last element followed by a right bracket ] and Enter. 
 
 
 
 
 
 
 
 
 
 
● Appending and colon operator 

You can create vectors by appending one vector to another. The colon operator : easily 
generates a large vector of regularly spaced elements. Typing 
 
 

Creates a vector x of values with a spacing q. The first value is m. The last value is n if 

EDU>> a = [1  2  3] 
a =  

   1   2   3 

EDU>> a = [1; 2; 3] 
 

a =  

     1 

     2 

     3 

EDU>> a = [ 1 
2 
3] 
 

a =  

     1 

     2 

     3 

>> a1  =  [0  0.1  0.2  0.3  0.4  0.5  0.6  0.7  0.8  0.9  1] 
a1 = 

  Columns 1 through 6  

         0    0.1000    0.2000    0.3000    0.4000 

0.5000 

  Columns 7 through 11  

0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0 

EDU>> x = [m:q:n] 
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m-n is an integer multiple of q. If not, the last value is less than n. If the increment q is 
omitted, it is presumed to be 1. 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

● How to create matrices 

The most direct way to create a matrix is to type the matrix row by row, separating the 
elements in a given row with spaces or commas and separating the rows with 
semicolons. If the matrix has many elements, you can press Enter and continue typing 
on the next line. MATLAB knows you are finished entering the matrix when you type 
the right bracket ]. 
 
 
 
 
 
 
 
 

>> a3 = [ 8  1  6 ; 3  5  7 ; 4  9  2 ] 

a3 = 

     8     1     6 

     3     5     7 

     4     9     2 

1 6 8 

5 7 3 

9 2 4 

>> a = [ 1 2]; 

>> b = [3 4]; 

>> c = [a b] 

c = 

     1   2   3   4 

>> d = [a,b] 

d =  

     1   2   3   4 

>> a4=1:10 

a4 = 

     1     2     3     4     5     6     7     8     9    10 

>> a5=1:2:10 

a5 = 

     1     3     5     7     9 

>> e = [a;b] 

e =  

1   2 

     3   4 

>> f = [a 

b] 

f =  

1   2 

     3   4 

first_term : final_term  (deafult 

increment=1)first_term : common_increment : final_term 
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● Matrices and the Transpose Operation 

The transpose operation interchanges the rows and columns. In mathematics text we 
denote this operation by the superscript T. MATLAB uses the transpose operator ‘. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

● Array Addressing 

Array indices are the row and column numbers of an element in an array and are used 
to keep track of the array’s elements. For example, the notation v(5) refers to the fifth 
element in the vector v, and A(2,3) refers to the element in row 2, column 3 in the 
matrix A. This notation enables you to correct entries in an array without retyping the 
entire array. For example, to change the element in row 1, column 3 of the matrix D to 6, 
you can type D(1,3) = 6. The colon operator selects individual elements, rows, columns, 
or “subarrays” of arrays. 
・ v(:) represents all the row or column elements of the vector v. 

>> a3 = [ 8 1 6  

3 5 7  

4 9 2 ] 

a3 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> a = [ 8 1 6  

3 5 7  

4 9 2 ] 

a3 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> b = a’ 

a5 = 

     8     3     4 

     1     5     9 

     6     7     2 

>> c = [ 8 1 6 ] 

c = 

     8     1     6 

>> d = c’ 

c = 

     8 

     1 

     6 

1 6 8 

5 7 3 

9 2 4 
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・ v(2:5) represents the second through fifth elements; that is v(2), v(3), v(4), 
v(5). 

・ A(:,3) denotes all the elements in the third column of the matrix A. 
・ A(:,2:5) denotes all the elements in the second through fifth columns of A. 
・ A(2:3,1:3) denotes all the elements in the second and third rows that are also 

in the first through third columns. 
 
 
 
 
 
 
 
 
● Some Useful Array Functions 

MATLAB has many functions for working with arrays. 
Command Description 

cat(n,A,B,C,…) Creats a new array by concatenating the arrays A,B,C, and so 
on along the dimension n. 

find(x) Computes an array containing the indices of the nonzero 
elements of the array x.  

[u,v,w] = find(A) Computes the arrays u and v, containing the row and column 
indices of the nonzero elements of the matrix A, and the array 
w, containing the values of the nonzero elements. The array w 
may be omitted. 

length(A) Computes either the number of elements of A if A is a vector 
or the largest value of m or n if A is an m×n matrix. 

linspace(a,b,n) Creates a row vector of n regularly spaced values between a 
and b. 

logspace(a,b,n) Creates a row vector of n logarithmically spaced values 
between a and b. 

max(A) Returns the algebraically largest element in A if A is a vector. 
Returns a row vector containing the largest elements in each 
column if A is a matrix. If any of the elements are complex, 
max(A) returns the elements that have the largest 
magnitudes. 

EDU>> A = [1  2  3  4  5 

6  7  8  9  0 

1  2  3  4  5]; 

EDU>> B = A(2:3,3:5) 

B =  

8  9  0 

3  4  5 

EDU>> A = [1  2  3  4  5 

6  7  8  9  0 

1  2  3  4  5]; 

EDU>> B = A([2,2],:) 

B =  

6  7  8  9  0 

6  7  8  9  0 
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[x,k] = max(A) Similar to max(A) but stores the maximum values in the row 
vector x and their indices in the row vector k. 

min(A) Same as max(A) but returns minimum values. 
[x,k] = min(A) Same as [x,k] = max(A) but returns minimum values. 
size(A) Returns a row vector [m,n] containing the sizes of the m×n 

array A. 
sort(A) Sorts each column of the array A in ascending order and 

returns an array the same size as A. 
sum(A) Sums the elements in each column of the array A and returns 

a row vector containing the sums. 
● Multidimensional Arrays 

MATLAB supports multidimensional array. A three-dimensional array has the 
dimension m×n×q. A four-dimensional array has the dimension m×n×q×r, and so 
forth. The first two dimensions are the row and column, as with a matrix. The higher 
dimensions are called pages. The elements of a matrix are specified by two indices; 
three indices are required to specified an element of a three –dimensional array, and so 
on. You can think of a three-dimensional array as layers of matrices. The first layer is 
page 1; the second layer is page 2, and so on. If A is a 3×3×2 array, you can access the 
element in row 3, column 2 of page 2 by typing A(3,2,2). To access all of page1, type 
A(:,:,1). Another way to produce a three-dimensional array is with the cat command, 
e.g., 
 
 
 
 
 
 
 
 
 

 

 

● Array Operations 

MATLAB is able to perform operations on matrices that are not available other 
languages; some of these operations are not even defined in linear algebra. Basic 
algebraic operations are very simple. 

EDU>> A=[1 2; 3 4]; 
EDU>> B=[5 6; 7 8]; 
EDU>> C=cat(3,A,B) 
C(:,:,1) =  

1   2 

     3   4 

C(:,:,2) =  

     5   6 

     7   8 
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If A=[aij] and A=[bij] are matrices and c is scalar, you can perform the following 
operations where : aij is the i-th row and j-th column element of the matrix A. 
・Element-by –element operations 

Notation Operation Math. notation for each element 
A+c Scalar addition [aij + c] 

A*c Scalar multiplication [aij * c] 

A+B Element-wise addition [aij + bij] 

A-B Element-wise subtraction [aij - bij] 

A.*B Element-wise multiplication [aij * bij] 

A./B Element-wise division [aij / bij] 

A.¥B Element-wise division [aij ¥bij] 

A.^c Element-wise powers [aij^c] 

c.^A Element-wise powers [c^aij] 

A.^B Element-wise powers [aij ^ bij] 

・Arithmetic operations 

Notation Operation Math. notation 
c*A Scalar multiplication [c aij] 

A+B Matrix addition [aij + bij] 

A-B Matrix subtraction [aij - bij] 

A*B Matrix multiplication [
P
aijbij] 

A/B Solution of linear equation xA = B BA-1 

A¥B Solution of linear equation Ax = B A-1B 

inv(A) Inverse matrix A-1 

pinv(A) Pseudo inverse matrix A+ 

・Matrix operations on linear equations 
Consider the following linear equation: 

Ax = b

A =

266664
a11 a12 ÅÅÅ a1m

a21 a22 ÅÅÅ a2m
...

...
. . .

...

an1 an2 ÅÅÅ anm

377775
x =

266664
x1

x2
...

xm

377775 ; b =
266664
b1

b2
...

bn

377775
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1) If m=n and A is nonsingular, then the solution A¥b is unique. 
2) If A is tall, i.e., m<n, then the equation is over-determined. A¥b gives you the 

minimum residual res = Ax – b. 
3) If A is fat, i.e., m>n, then the equation is under-determined. A¥b gives you the 

maximum zero element and pinv(A)*b gives you the minimum norm solution. 
●Examples 

・ linspace and logspace 
 

 

 

 

 

 

 

 

 

 

 

 

・ Arithmetic calculations and linear equation 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

linspace generates linearly spaced vectors 

linspace(d1,d2) : 50points linearly equally spaced between d1 anr d2 

>> linspace(1,100) 

linspace(d1,d2,n) : n points linearly equally spaced between d1 anr d2 

>> linspace(1,100,20) 

logspace generates logarithmically spaced vectors 

logspace(d1,d2) : 50 points logarithmically euqally spaced between 10d1 and 10d2 

>> logspace(-2,3) 

logspace(d1,d2,n) : n points 

>> logspace(-2,3,100) 

>>A=[1 2;3 4] 

>>B=[5 6;7 8] 

>>C=A + B 

>>D=A - B 

>>E=A * B 

>>F=A¥B 

>>G=A/B

>> A=[1 2 3; 4 5 6] 
A = 

     1     2     3 

     4     5     6 

>> b = [ 7 8]' 
b = 

     7 

     8 

>> A¥b 
ans = 

           -3 

            0 

       3.3333 

>> A=[1 2 3; 4 5 6] 
A = 

     1     2     3 

     4     5     6 

>> b = [ 7 8]' 
b = 

     7 

     8 

>> pinv(A)*b 
ans = 

      -3.0556 

      0.11111 

       3.2778 
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・ Array operations 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

>> a1=1:10 
a1 = 

     1     2     3     4     5     6     7     8     9    10 

>> size(a1) 
ans = 

     1    10 

>> b=a1(3) 
b = 

     3 

>> b=a1(1,3) 
b= 

     3 

size → [row  col] 

3rd element 

1st row, 3rd column 

create a sequence 

>> a2=magic(3) 
a2 = 

    8   1   6 

    3   5   7 

    4   9   2 

>> a2=magic(3) 
a2 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> a2(1,1:2) 
ans = 

     8     1 

>> a2(2:3,3) 
ans = 

     7 

     2 

magic(n) produces magic square, i.e., an n-by-n matrix constructed from the
integers 1 through n2 with equal row, column, and diagonal sums. 
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>> a2=magic(3) 
a2 = 

    8   1   6 

    3   5   7 

    4   9   2 

>> a2=magic(3) 
a2 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> a2(2,:) 
ans = 

    3   5   7 

>> a2(:,2:3) 
ans = 

     1 

     5 

     9 

>> a2=magic(3) 
a2 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> r=[2 3] 
r = 

     2     3 

>> c=[1 3] 
c = 

     1     3 

>> a2(r,c) 
ans = 

     3     7 

     4     2 

>> a2=magic(3) 
a2 = 

     8     1    6 

     3     5    7 

     4     9    2 

>> a2(:) 
ans = 

     8 

     3 

     4 

     1 

     5 

     9 

     6 

     7 

     2 
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>> a2=magic(3) 
a2 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> a2 
a2 = 

     8     1     6 

     3     5   -10 

     4     9     2 

>> a2(2,3)=-10 

>> a2=magic(3) 
a2 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> a2 
a2 = 

      8     1     6 

      3    -2    -3 

      4     9     2 

>> a2(2,2:3)=[-2 -3] 

>> a2=magic(3) 
a2 = 

     8     1     6 

     3     5     7 

     4     9     2 

>> find(a2>5) 
ans = 

     1 

     6 

     7 

     8 

>> a2>=5 
ans = 

     1     0     1 

     0     0     1 

     0     1     0 

Find elements 

which is greater than 5 

Find(A) returns a vector containing the indices of the nonzeros of vector A. 

If A is a matrix, “find” regards A as A(:)(column vector).
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・ Example : Vectors and displacement 

 

 

 

 

 

 

 

 

Solution 

(a) Using the xyz coordinates selected, the position of diver 1 is r = 55i + 36j + 

25k. The distance from the origin of a point xyz is given by 
p
x2 + y2 + z2, 

that is, by the magnitude of the vector pointing from the origin to the point 
xyz. This distance is computed in the following session. 

 
 
 
 
 
 

(b) The location of diver 1 to diver 2 is given by the vector v pointing from diver 
1 to diver 2. We can find this vector using vector subtraction: v = w – r. 
Continue the above MATLAB session as follows: 

>> a4 
a4 = 

           8 + 8i 

           3 + 1i 

           4 + 6i 

>> a4' 
ans = 

           8 - 8i       3 - 1i       4 - 6i 

>> a4.' 
ans = 

           8 + 8i       3 + 1i       4 + 6i 

Complex matrix 

Conjugate transpose 

transpose 

Suppose two divers start at the surface and estblish the following coordinate
system: x is to the west, y is to the north, and z is down. Diver 1 swims 55 feet
west, 36 feet north, and then dives 25 feet. Diver 2 dives 15 feet, then swims
east 20 feet and then north 59 feet. 
(a) Find the distance between diver 1 and the starting point. 
(b) How far in each direction must diver 1 swim to reach diver 2? How far in a

straight line must diver 1 swim to reach diver 2? 

EDU>> r = [55, 36, 25]; 
EDU>> w = [-20, 59, 15]; 
EDU>> dist1 = sqrt(sum(r.*r)) 
dist1 =  

   70.3278 

sum returns the sum of
elements of vector. 
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Thus to reach diver 2 by swimming along the coordinate directions, diver 1 
must swim 75 feet east, 23 feet north, and 10 feet up. The straight-line distance 
between them is approximately 79 feet. 

● Special Matrices 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EDU>> v = w – r 
v =  

   -75   23   -10 

EDU>> dist2 = sqrt(sum(v.*v)) 
dist2 =  

   79.0822 

Elementary matrices. 

    zeros       - Zeros array. 
    ones        - Ones array. 
    eye         - Identity matrix. 
    repmat      - Replicate and tile array. 
    rand        - Uniformly distributed random numbers. 
    randn       - Normally distributed random numbers. 
    linspace    - Linearly spaced vector. 
    logspace    - Logarithmically spaced vector. 
    freqspace   - Frequency spacing for frequency response. 

Specialized matrices. 

    hadamard    - Hadamard matrix. 
    hankel      - Hankel matrix. 
    invhilb     - Inverse Hilbert matrix. 
    magic       - Magic square. 
    pascal      - Pascal matrix. 
    rosser      - Classic symmetric eigenvalue test problem. 
    toeplitz    - Toeplitz matrix. 
    vander      - Vandermonde matrix. 
    wilkinson   - Wilkinson's eigenvalue test matrix. 
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ones：Generates all-ones matirces 

>> ones(2,3) 
ans = 

     1     1     1 

     1     1     1  

zeros：all-zeros matrices 

>> zeros(2,3) 
ans = 

     0     0     0 

     0     0     0 

eye：Generates identity matirces  

>> eye(3) 
ans = 

     1     0     0 

     0     1     0 

     0     0     1 

>> eye(3,2) 
ans = 

 1     0 

 0     1 

 0     0 

size: Return the size of 

matrices 

>> x=[1 3 0 
      1 1 2] 
x = 

     1     3     0 

     1     1     2 

>> size(x) 
ans = 

     2     3 

Length:Return the length of vector

>> y=[1 2 3] 
y = 

     1     2     3 

>> length(y) 
ans = 

     3  

reshape:change the sizes of 

row and column of 

matrices 

>> A = [ 1  2 ; 3  4 ]; 
>> reshape(A,1,4) 
ans =  

  1   3   2   4 

>> reshape(A’,1,4) 
  ans =  

    1   2   3   4  

repmat:generate matrices with same elements

>> repmat(3,2,5) 
ans = 

     3     3     3     3     3 

     3     3     3     3     3  
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● Matrix Operation (singularity of matrix) 

Command Description 
rank(A) 
rank(A,tol) 

Rank of matrix A, equivalently 
Number of non-zero elements of svd(A). 

cond(A) Condition number of matrix A, i.e., max(svd(A))/min(svd(A)). 
det(A) Determinant of matrix A, equivalently, prod(svd(A)). 
svd(A) Singular value decomposition of matrix A. 
・ Singular value decomposition 

In control theory, transfer function poles and eigenvalues of the A matrix in the 
state space representation have played key roles in stability analysis. Similarly, 
the notion of singular values plays a key role in robust stability analysis of 
multivariable systems. 
 

 

 

 

 

 

 

・ Example 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A=USV’ 

  A:m by n 

  U:m by m 

  V:n by n 

Unitary matorices 

  U’U=UU’=I 

V’V=I

S=[S1 0]  if n>m 

S=[S1 

        0]     if n<m 

S=[S1]     if n=m 

S1=diag[σ1,…,σk] 

k=min(m,n) 

σ1=max ||Ax||/||x|| 

    ||x|| 

>> format  rat 
>> A=hilb(4) 
A = 

    1   1/2   1/3   1/4 

  1/2   1/3   1/4   1/5 

  1/3   1/4   1/5   1/6 

  1/4   1/5   1/6   1/7 

>> format  short  g 
>> cond(A) 
ans = 

   15514 

>> det(A) 
ans = 

  1.6534e-007 

>> svd(A) 
ans = 

       1.5002 

      0.16914 

    0.0067383 

  9.6702e-005 

>> rank(A) 
ans = 

     4 

>> rank(A,1e-4) 
ans = 

     3 
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● Matrix Operation (Eigen-structure) 

・ Eigenvalue and eigenvectors 

If A is an n-by-n matrix, the n numbers λ’s that satisfy Ax = λx are the 
eigenvalues of A and vectors x’s are the eigenvectors of A. They are found using 
 
 
which returns the eigenvalues in a column vector. Eigenvalues and eigenvectors 
are obtained with a double assignment statement, 
 
 
in which case the diagonal elements of D are the eigenvalues and the columns of 
X are the corresponding eigenvectors such that AX = XD. 
If A and B are square matrices, the function eig(A,B) returns a vector 
containing the generalized eigenvalues solving the equation Ax = λBx. The 
double assignment is used to obtain eigenvectors 
 
 
Producing a diagonal matrix D of generalized eigenvalues and a full matrix X 
whose columns are the corresponding eigenvectors so that AX = BXD. 

Command Description 
[V,D] = eig(A) Eigen-structure of matrix A. 
[V,D,S] = condeig(A) Condition number with respect to eigenvalues. 

 
・ Examples 

 

 

 

 

 

 

 

 

 

 

 

EDU>> eig(A) 

EDU>> [X,D] = eig(A) 

EDU>> [X,D] = eig(A,B) 

>> A=vander([1 2 3 4]) 
A = 

     1     1     1     1 

     8     4     2     1 

    27     9     3     1 

    64    16     4     1 

>> eig(A) 
ans = 

        15.49 

      -7.7063 

       1.2942 

    -0.077675 

C : n-th order vector 
vander(C) 
vander(i,j)=C(i)(n-j) 
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● Matrix Operation (Exponential, logarithm, square root) 

exp, log, and log10 are elementary functions that operate elementwise on matrices. 
Their domain includes complex numbers that can lead to unexpected results if used 
unintentionally. 

exp(X) returns ex for each of the elements of X. For complex z = x+jy, the complex 
exponential is returned: 

ez = ex(cos y+j siny) 

log(X) is the natural logarithm of the elements of X. For complex or negative z, the 
complex logarithm is returned: 

log z = log(abs(z))+jatan2(y; x) 

>> condeig(A) 
ans = 

       2.9975 

       3.6431 

       1.8698 

       1.2185 

Condition number measures the
sensitivity of the solution of a system of
linear equations to errors in the data. 

>> [V,D]=eig(A) 

V = 

    0.1064    0.1378    0.1292   -0.0523 

    0.2286    0.0361   -0.4076    0.3756 

    0.4627   -0.2895   -0.3763   -0.7942 

    0.8499   -0.9465    0.8219    0.4749 

D = 

   15.4897         0         0         0 

         0   -7.7063         0         0 

         0         0    1.2942         0 

         0         0         0   -0.0777 

eigenvectors 

eigenvalues 
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log10(X) is log10 of the elements of X. 
sqrt(X) is the square root of the elements of X. Complex results are produced for the 
elements of X that are negative or complex. 
expm(X) is the matrix exponential of a square matrix X, i.e., 

eX = I + X + 1
2!X

2 + 1
3!X

3 + ÅÅÅ 
logm(X) is the matrix logarithm of a square matrix X. 
sqrt(X) is the square root of a square matrix X. 
 

● Example (linear algebra and electric circuit) 
 
 
 
 
 
 
 
 
 
 
 
 

Zi1 = v

v = 10ji1 + 10(i1 + i2)

0 = 10(i1 + i2) + (5 +
1

0:5j
)i2

If v = 1 then, we have"
10 + 10j 10

10 15 + 1
0:5j

#"
i1

i2

#
=

"
1

0

#
 

 
 
 
 
 
 
 

 1 

0.5j 

10j 

10 

5 

i1 i2 

v
Z 

How much 

Impedance? 

>> j=sqrt(-1); 

>> A=[10+10j 10 

10  15+1/0.5j]; 

>> b=[ 1 0 ]'; 

>> X=A¥b; 

>> Z=1/X(1) 

ans = 

      3.4498 + 9.1266 

>> abs(Z) 

ans = 

       9.7569 

>> angle(Z)*180/pi 

ans = 

       69.294 Z=3.45+9.12j[Ω] 

 =9.7567∠69.3°[Ω] 
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4. Polynomials 
● Representation in MATLAB 

MATLAB has some convenient vector-based tools for working with polynomials, which 
are used in many advanced courses and applications in engineering. Type help polyfun 
for more information on this category of commands. We will use the following notation 
to describe a polynomial: 

f(x) = a1xn+a2xnÄ1+ÅÅÅ+anÄ1x2+anx+an+1 
This polynomial is a function of x. Its degree or order is n, the highest power of x that 
appears in the polynomial. The ai; i = 1; 2;ÅÅÅ; n+ 1  are the polynomial’s 
coefficients. We can describe a polynomial in MATLAB with a row whose elements 
are the polynomial’s coefficients, starting with the coefficient of the highest power of x. 
This vector is  h

a1 a2 ÅÅÅ anÄ1 an an+1

i
. 

For example, the vector [1, 2, 3] represents the polynomial x2 + 2x+ 3. 
● Polynomial Algebra and MATLAB Functions 

To add two polynomials, add the arrays that describe their coefficients. If the 
polynomials are of different degree, add zeros to the coefficient array of the lower-degree 
polynomials. For example, consider 

f(x) = 2x3 + 3x2 + 4x+ 5 
whose coefficient array is f = [2, 3, 4, 5] and 

g(x) = 6x2 + 7x+ 8 
whose coefficient array is g = [6, 7, 8]. The degree of g(x) is one less that of f(x). 
Therefore, to add f(x) and g(x), we append one zero to MATLAB into thinking g(x) is a 
third-degree polynomial. That is, we type g = [0, g] to obtain [0, 6, 7, 8] for g. To add the 
polynomials, type h = f + g. The result is h = [2, 9, 11, 13]. Subtraction is done in a 
similar way. 
To multiply a polynomial by a scalar, simply multiply the coefficient array by that scalar. 
Multiplication of polynomials by hand can be tedious, and polynomial division is even 
more so, but these operations are easily done with MATLAB. Use the conv function to 
multiply polynomials and use the deconv function to perform synthetic division. 

Command Description 
conv(a,b) Computes the product of the two polynomials described by 

the coefficient arrays a and b. The two polynomials need not 
to be the same degree. The result is the coefficient array of 
the product polynomial. 
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[q,r]=deconv(num,den) Computes the result of dividing a numerator polynomial, 
whose coefficient array is num, by a denominator polynomial 
represented by the coefficient array den. The quotient 
polynomial is given by the coefficient array q, and the 
remainder polynomial is given by the coefficient array r. 

poly(r) Computes the coefficients of the polynomial whose roots are 
specified by the vector r. The result is a row vector that 
contains the polynomial’s coefficients arranged in 
descending order of power. 

polyval(a,x) Evaluates a polynomial at specified values of its independent 
variable x, which can be a matrix or a vector. The 
polynomial’s coefficients of descending powers are stored in 
the array a. The result is the same size as x. 

roots(a) Computes the roots of a polynomial specified by the 
coefficient array a. The result is a column vector that 
contains the polynomial’s roots. 

● Example 
f(x) = 9x3 Ä 5x2 + 3x+ 7
g(x) = 6x2 Ä x+ 2

f(x)g(x) = (9x3 Ä 5x2 + 3x+ 7)(6x2 Ä x+ 2)
= 54x5 Ä 39x4 + 41x3 + 29x2 Ä x+ 14

f(x)

g(x)
=

6x2 Ä x+ 2
6x2 Ä x+ 2

= 1:5xÄ 0:5833 with remainder Ä 0:5833x+ 8:1667 
 
 
 
 
 
 
 
 
 
 
 
 
 

EDU>> f = [9, -5, 3, 7]; 

EDU>> g = [6, -1, 2]; 

EDU>> product = conv(f,g) 

Product = 

54  -39  41  29  -1  14 

EDU>> [quotient, remainder] = deconv(f,g) 

quotient =  

   1.5   -0.5833 

remainder =  

   0   0   -0.5833   8.1667 

EDU>> roots(g) 

ans = 

   0.0833 + 0.5713i 

   0.0833 - 0.5713i 

EDU>> polyval(g,2) 

ans =  

   24 
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5. Working with Files 
MATLAB uses several types of files that enable you to save programs, data, and session 
results. 
● Directories and Search Path 

It is important to know the location of files you use with MATLAB. File location 
frequently causes problems for beginners. If you bring a floppy disk to use with 
MATLAB on another computer, say, in a school’s computer lab, you must make sure that 
MATLAB knows how to find your files. Files are stored in directories, calls folders on 
some computer systems. Directories can have subdirectories below them. For example, 
suppose MATLAB was installed on drive C: in the directory c:¥matlab. Then the 
toolbox directory is a subdirectory under the directory c:¥matlab, and symbolic is a 
subdirectory under the toolbox directory. The MATLAB search-path tells us and 
MATLAB how to find a particular file.  
● Working with Floppy Disks 

Suppose you have saved the file problem1.m in the directory ¥homework on a floppy 
disk which you insert in drive a:. The MATLAB search-path for this file is 
a:¥homework. As MATLAB is normally installed, when you type problem1, 
1) MATLAB first checks to see if problem1 is a variable and if so, displays its value. 
2) It not, MATLAB then checks to see if problem1 is one of its own built-in commands, 

and execute it if it is. 
3) If not, MATLAB then looks in the current directory for a file named problem1.m, 

and executes problem1 if it finds it. 
4) If not, MATLAB then searches the directories in its search-path, in order, for 

problem1.m and then executes it if found. 
You can display the MATLAB search-path by typing path. If problem1 is on the floppy 
disk only and if directory a: is not in the search-path, MATLAB will not find the file and 
will generate an error message, unless you tell it where to look. You can do this by 
typing cd a:¥homework, which stands for “change directory to a:¥homework”. This will 
change the current directory to a:¥homework and force MATLAB to look in that 
directory to find your file. 
 
You can display the current directory by typing pwd. To see a list of all the files in the 
current directory, type dir. 
 
You can add a directory to the search-path by using the addpath command. To remove a 
directory from search-path, use the rmpath command. The Path Browser is a graphical 
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interface for working with files and directories. Type pathtool to start the browser. To 
save the path setting, click on Save in the browser. To restore the default search-path, 
click on Default Path in the browser. 

Command Description 
addpath  dirname Adds the directory dirname to the search path. 
cd  dirname Changes the current directory to dirname. 
dir Lists all files in the current directory. 
dir  dirname Lists all the files in the directory dirname. 
path Displays the MATLAB search-path. 
pathtool Starts the Path Browser. 
pwd Displays the current directory. 
rmpath  dirname Removes the directory dirname from the search-path. 
what Lists the MATLAB-specific files found in the current working 

directory. Most data files and other non-MATLAB files are not 
listed. Use dir to get a list of all files. 

what  dirname Lists the MATLAB-specific files in directory dirname. 

6. Decision-Making Functions  
The usefulness of MATLAB greatly increases with its ability to use decision-making 
functions in its programs. These functions enables you to write programs whose 
operations depend on the results of calculations made by the program. 
● Relational Operations 

MATLAB has six relational operators to make comparisons between arrays.  
The comparison is done between the pairs of corresponding elements; the result is a 
matrix of ones or zeros, with one representing TRUE and zero FALSE. 

Relational 
Operator 

Meaning Relational 
Operator 

Meaning 

< Less than. >= Greater than or equal to 
<= Less than or equal to = = Equal to. 
> Greater than. ~= Not equal to. 

 
 
 
 
 

EDU>> x = [1 5]; 

EDU>> y = [3 2]; 

EDU>> z = x<y 

z =  

  0   1 

EDU>> z2 = x==y 

z2 =  

 0   0 
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● Logical Operations 

MATLAB has three logical operators, which are sometimes called Boolean operators. 
These operators perform element-by-element operations. “&” and “|” operators compare 
two scalars, or two matrices of equal dimensions. For matrices, they work elementwise.

Operator Name Definition 
~ NOT ~A returns an array the same dimension as A; the new array 

has ones where A is zero and zeros where A is nonzero. 
& AND A & B returns an array the same dimension as A and B; the 

new array has ones where both A and B have nonzero 
elements and zeros where either A or B is zero. 

| OR A|B returns an array the same dimension as A and B; the 
new array has ones where at least one element in A or B is 
nonzero and zeros where A and B are both zero. 

 
Operator Name Definition 

xor Exclusive 

OR 

Xor(A,B) returns zeros where A and B are either both 
nonzero or both zero, and ones where either A or B is 
nonzero, but not both. 

The truth table is obtained by the following MATLAB M-file. 
  Truth Table 

x y ~x x|y x&y xor(x,y) 

True True False True True False 
True False False True False True 
False True True True False True 
False False True False False False 

  MATLAB M-file 
 
 
 
 
 
 
 
 
 
 

EDU>> x = [1, 1, 0, 0]’; 

EDU>> y = [1, 0, 1, 0]’; 

EDU>> Truth_Table = [x, y, ~x, x|y, x&y, xor(x,y)] 

Truth_Table =  

1  1  0  1  1  0 

1  0  0  1  0  1 

0  1  1  1  0  1 

0  0  1  0  0  0 
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● Relational and Logical operations (element-by-element operations) 

 
 

Notation Operation Math. Notation 
A = = c Equal to [aij = c] 
A ~= c Not equal to [aij≠c] 
A < c Less than [aij < c] 
A > c Greater than [aij > c] 

A <= c Less than or equal to [aij <= c] 
A >= c Greater than or equal to [aij >= c] 

 
A & B Logical and [aij and bij] 
A | B Logical or [aij or bij] 
~A Logical not [not aij] 

● Relational and Logical operations (special functions) 

Logical function Definition 
any(x) Returns a scalar, which is 1 if any of the elements in the vector x is 

nonzero and 0 otherwise. 
any(A) Returns a row vector having the same number of columns as A 

and containing ones and zeros, depending on whether or not the 
corresponding column of the matrix A contains any nonzero 
elements. 

all(x) Returns a scalar, which is 1 if all the elements in the vector x are 
nonzero and 0 otherwise. 

all(A) Returns a row vector having the same number of columns as the 
matrix A and containing ones and zeros, depending on whether or 
not the corresponding column of A has all nonzero elements. 

find(A) Computes an array containing the indices of the nonzero elements 
of the array A. 

[u,v,w] = find(A) Computes the arrays u and v containing the row and column 
indices of the nonzero elements of the array A and computes the 
array w containing the values of the nonzero elements. The array 
w may be omitted. 

finite(A) Returns an array of the same dimension as A with ones where the 
elements of A are finite and zeros elsewhere. 

A=[aij], B=[bij]   : matrix,        c:    scalar 
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isnan(A) Returns an array of the same dimension as A with ones where A 
has ‘NaN’ and zeros elsewhere. 

isinf(A) Returns an array of the same dimension as A with ones where A 
has ‘inf‘ and zeros elsewhere. 

isempty(A) Returns a 1 if A is an empty matrix and 0 otherwise. 
isreal(A) Returns a 1 if A has no elements with imaginary parts and 0 

otherwise. 
● Examples 

 
 
 
 
 
 
 
 
 
 
● Example (Height and speed of a projectile) 

 
 
 
 
 
 
 
 
 
 
 
Solution 

The key to solving this problem with relational and logical operators is to use the find 
command to determine the times at which the logical expression (h >= 6) & (v <= 16) is 
true. First we must generate the vectors h and v corresponding to times t1 and t2 
between 0≦t≦thit, using a spacing for time t that is small enough to achieve sufficient 
accuracy for our purposes. We will choose a spacing of thit/100, which provides 101  

EDU>> x = [5, -3, 0, 0, 8]; 

EDU>> y = [2, 4, 0, 5, 7]; 

EDU>> x&y 

ans =  

   1   1   0   0   1 

EDU>> z = find(x&y) 

z =  

   1   2   5 

EDU>> x = [5, -3, 0, 0, 8]; 

EDU>> y = [2, 4, 0, 5, 7]; 

EDU>> values = y(x&y) 

values =  

   2   4   7 

EDU>> how_many = length(values) 

how_many =  

   3 

The height and speed of a projectile (such as a thrown ball) launched with a speed of v0

at an angle A to the horizontal are given by 

h(t) = v0t sinAÄ 0:5gt2

v(t) =
q
v20 Ä 2v0gt sinA+ g2t2 

where g is the acceleration due to gravity. The projection will strike the ground when
h(t) = 0, which gives the time to hit, thit = 2(v0/g)sin A. Suppose that A = 40°, v0 = 20

meters/second, and g = 9.81 meters/second2. Use the MATLAB relational and logical
operators to find the times when the height is no less than 6 meters and the speed is
simultaneously no greater than 16 meters/second. 
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values of time. When computing the times t1 and t2, we must subtract 1 from u(1) and 
from length(u) because the first element in the array t corresponds to t=0 (that is, t(1) is 
0). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The results are t1 = 0.8649 and t2 = 1.7560. Between these two times h≧6 meters and v 

≦16 meters per second. 
 

7. Text Operations and Time Functions 
A string is a variable that contains characters. Strings are useful for creating input 
prompts and messages and for storing and operating on data such as names and 
addresses. To create a string variable, enclose the characters in single quotes. 
 
 
 
 
 
 
 
 
 

Script M-file 

% Set the values  

v0 = 20; g = 9.81; A = 40*pi/180; 

% Compute the time to hit. 

t_hit = 2*v0*sin(A)/g; 

% Compute the arrays containing time, height, and speed. 

t = [0:t_hit/100:t_hit]; 

h = v0*t*sin(A) – 0.5*g*t.^2; 

v = sqrt(v0^2 – 2*v0*g*sin(A)*t + g^2*t.^2); 

% Determine when the height is no less than 6, 

% and the speed is no greater than 16. 

u = find(h>=6 & v<=16); 

% Compute the corresponding times. 

t_1 = (u(1)-1)*(t_hit/100) 

t_2 = u(length(u)-1)*(t_hit/100) 

>> str='ABCDE' 

str = 

ABCDE 

>> whos 

  Name   Size    Bytes  Class 

  str    1x5     10  char array

>> double(str) 

ans = 

    65    66    67    68    69 

>> fliplr(str) 

ans = 

EDCBA 

>> x='FGHIJKLM' 

x = 

FGHIJKLM 

>> [str  x] 

ans = 

ABCDEFGHIJKLM 
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Command Description 

base2dec(S,B) Convert base B string S to decimal integer. 
bin2dec(B) Convert binary string S to decimal integer. 
char(A) Convert ASCII code (double) to string (char). 
double(S) Convert string S to ASCII code. 
dec2hex, dec2base,dec2bin,hex2dec,hex2num,int2str,mat2str,str2num,num2str 

fprintf Write formatted data to file. 
sprintf Write formatted data to string. 
sscanf Read string under format control. 

 
Command Description 

blanks(n) String of n blanks. 
deblank(S) Remove trailing blanks. 
eval(S) Execute string with MATLAB expression. 
eval(try,catch) Execute string and catch the error. 
feval(try,catch) Execute the specified function. 
Findstr, ischar, isletter, isspace, lasterr, lower, strcat, strcmp, strjust, strmatch, 

strncmp, strrep, strtok, strvcat, upper 

For detail, type help strfun. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

>> C={'ABC','DEFG','HIJKLMN','OP'} 

C =  

  'ABC'  'DEFG'  'HIJKLMN'  'OP' 

>> C{1} 

ans = 

ABC 

>> C{2} 

ans = 

DEFG 

>> C{3} 

ans = 

HIJKLMN 

>> [C{1} C{2} C{3}] 

ans = 

ABCDEFGHIJKLMN 

>>C(1) 

ans =  

    'ABC' 
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Command Description 

now Current date and time as date number. 
date Current date as date string. 
clock Current date and time as date vector. 
datenum Serial date number. 
datestr String representation of date. 
datevec Date component. 
calender Calender. 
weekday Day of week. 
datetick Date formatted tick labels. 

For detail, type help timefun. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

>> clock 

ans = 

  Columns 1 through 5  

         2001            1            3           11           15

  Column 6  

        49.51 

>> now 

ans = 

  7.3085e+005 

>> datestr(now,26) 

ans = 

2002/12/18 

>> date 

ans = 

18-Dec-2002 
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8. Programming with MATLAB 
The MATLAB interactive mode is very useful for simple problems, but more complex 
problems require a script M-file. Such a file can be called a computer program, and 
writing such a file is called programming. The usefulness of MATLAB is greately 
increased by the use of decision-making functions in its programs. These functions 
enables you to write programs whose operations depend on the results of calculations 
made by the program. MATLAB has control flow statements like those found in most 
computer languages. The control flow statements carry simple desk calculator, allowing 
it to be used as a complete high-level matrix language. 
 
MATLAB has procedural language rules 
・ sequential execution, 
・ branch execution (if-end, if-else-end, switch-case), 

・ repetitive execution (for-end, while-end), and 
・ function call. 

● Sequential Execution 

 

 

 

 

 

 

 

 

 

 

・Example : How to swap the contents of variables a and b 
 
 
 
 
 
 
 
 

>> a=2;b=3; 

>> [a b] 

ans = 

     2     3 

>> tmp=a;a=b;b=tmp; 

>> [a b] 

ans = 

     3     2 

command_1 

command_2 

command_3 

command_1 

command_2 

command_3 

 ... 

M-file program 

a=2; 

b=3; 

[a b] 

tmp=a; 

a=b; 

b=tmp; 

[aa b] 

M-file program 
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● Branch Execution (if statement) 

In every language we describe our decision making by using conditional phases such as, 
if I get a raise, I will buy a new car. If the statement, “I get a raise”, is true, the action 
indicated (buy a new car) will be executed. Here is another example: If I get at least a 
$100 per week raise, I will buy a new car; else, I will put the raise into savings. A 
slightly more involved example is: If I get at least a $100 per week raise, I will buy a 
new car; else, if the raise is greater than $50, I will buy a new stereo; otherwise, I will 
put the raise into savings. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

If expression1 is true, the first set of statements is executed; 
If expression2 is true, then the next set of statements is executed; 
Otherwise, the statement after else are executed. 

Syntax 
if expression1 

statements 

elseif expression2 

statements 

else 

statements 

end 

Example 
If a>0 

   b = a 

else if a<0 

   b = -a 

else 

   b = 1 

end 

expression1 

statements 
expression2 

statements 

statements 

True 

True 

False 

False 

Expression1 and 2 can be
written by relational
operators and logical
operators. 
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・ Example (if- end) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
・ Example (if-else-end) 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

x = input(‘x=’) 

if x >= 0 

   y = sqrt(x) 

end 

x = input(‘x=’) 

if x>=0, y=sqrt(x), end 

If structure may be written on a single line. 

x = input(‘x=’) 

y = input(‘y=’) 

if (x >= 0) & (y >= 0) 

  z = sqrt(x) + sqrt(y) 

  w = log(x) - 3*log(y) 

end 

x = input(’x=’) gives the user the prompt in the
text string and then waits for input from the
keyboard. The input can be any MATLAB
expression, which is evaluated, using the variables
in the current workspace, and the result returned
in x.  If the user presses the return key without
entering anything, INPUT returns an empty
matrix. 

x = input(‘x=’) 

if x >= 0 

  y = sqrt(x) 

else 

  y = exp(x) - 1 

end 

x = [4, -9, 25] 

if x < 0 

  disp(‘Some of the elements of x are negative.’) 

else 

  y = sqrt(x) 

end 

Executed result 
y =  
  2    0 + 3.000i   5 

Attention!: The logical expression may be an array, but the if statement returns a
value of TRUE only if all elements of the logical expression are nonzero. In this
case, x<0 returns the vector [0, 1, 0], thus the if-statement returns TRUE. 

disp(array) displays the array, without printing the array name. When you want
to display an output-message, type disp(‘write down your output-massage’). 
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・ Examples (if-elseif-else-end) 

 
 
 
 
 
 
 
 
 
 
 
 
The else and elseif statements may be omitted if not required. However, if both are used, 
the else statement must come after the elseif statement to take care of all conditions 
that might be unaccounted for. 
 
Decision structure may be nested; that is, one structure can contain another structure, 
which in turn can contain another, and so on. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

x = input(‘x=’) 

if x >= 5 

  y = log(x) 

else 

  if  x >= 0 

     y = sqrt(x) 

  else 

     y = sqrt(-x) 

  end 

end 

x = input(‘x=’) 

if x >= 5 

  y = log(x) 

elseif  x >= 0 

  y = sqrt(x) 

else 

  y = sqrt(-x) 

end 

Equivalent 

x = input(‘x=’) 

if x >= 10 

  y = log(x) 

  if y >= 3 

    z = 4*y 

  elseif y >= 2.5 

    z = 2*y 

  else 

    z = 0 

  end 

else 

  y = 5*x 

  z = 7*x 

end 
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● Branch Execution (switch statement) 

The switch structure provides an alternative to using the if, elseif, and else commands. 
Anything programmed using switch can also be programmed using if structures. 
However, for some applications the switch structure is more readable than code using 
the if structure. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The input expression is compared to each value. If they are the same, then
the statements following that case statement are executed and processing
continues with any statements after the end statement. 

Syntax 
switch input_expression 

   case value1 

     statements 

   case value2 

   ．．． 

   otherwise 

     statements 

end 

Example 
a = input(‘a=’) 

switch  a 

case  0 

      disp(‘X’) 

case  1 

      disp(‘Y’) 

otherwise 

      disp(‘Z’) 

end 

sex = input('Are you male[1] or female[2]?'); 

switch sex 

case 1 

    disp('Hello, Boy.') 

case 2 

    disp('Hello, Girl.') 

otherwise 

    disp('Hello.') 

end 

MATLAB Editor  Save switch1.m 

>> switch1 

Are you male[1] or female[2]?1 

Hello, Boy. 

>> switch1 

Are you male[1] or female[2]?2 

Hello, Girl. 

>> switch1 

Are you male[1] or female[2]?10 

Hello. 

command window 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
60 

● Repetive execution (for loops) 

A loop is a structure for repeating a calculation a number of times. Each repetition of 
the loop is a pass. MATLAB uses two types of explicit loops: the for loop, when the 
number of passes is known ahead of time, and the while loop, when the looping process 
must terminate when a specified condition is satisfied, and thus the number of passes is 
not known in advance. 
・ for Loops 

MATLAB has its own version of the “DO” or “FOR” loop found in other computer 
languages. It allows a statement, or group of statements, to be repeated a fixed, 
predetermined number of times. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The expression m:s:n assigns an initial value of m to the loop_variable,
which is incremented by the value s – called the step value or
incremental value. The statements are executed once during each pass,
using the current value of the loop_variables. The looping continues until the
loop_variable exceeds the terminate value n. 

Syntax 
for  loop_variable  =  m:s:n 

     statements 

end 

 

Example 
a=0 

for i=1:10 

  a=a+i; 

end 

Start of for-loop 

x=column of array 

commands 

Start of for-loop 

for x = array 

    commands ... 

end 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
61 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

>> a=0; 

>> for i=1:10 

a=a+i; 

end 

>> a 

a = 

    55 

>> for i=1:3 

for j=1:3 

  a(i,j) = 1/(i+j-1); 

end 

end 

>> a 

 

a = 

 

    1.0000    0.5000    0.3333 

    0.5000    0.3333    0.2500 

    0.3333    0.2500    0.2000 

Command-based-exec. 

 

 

 

a=0; 

for i=1:10 

a=a+i; 

end 

 

 

 

for i=1:3 

for j=1:3 

  a(i,j) = 1/(i+j-1); 

end 

end 

Mfile-based-exec. 

 

 
>>exfor1 

>> a 

a = 

    55 

MATLAB Editor 
(save exfor1.m) 

MATLAB Editor 
(save exfor2.m) 

Command Window 
 

 
>>exfor2 

>> a 

a = 

    1.0000   0.5000    0.3333 

    0.5000   0.3333    0.2500 

    0.3333   0.2500    0.2000

Command Window 
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・ Implied Loops 

Many MATLAB commands contain implied loops. For example, consider these 
statements. 
 

 

 

To achieve the same result using a for loop, we must type 
 
 
 

>> for i=1:5;  x(i)=sin(pi*i/5);  end 

>> x 

x = 

      0.58779      0.95106      0.95106      0.58779  1.2246e-016 

>> data=[1 2 3 4; 1 4 9 16]; 

>> for n=data;  x=n(1)-n(2) 

  end 

x = 

     0 

x = 

    -2 

x = 

    -6 

x = 

   -12 

>> data ='ABCDEFGHIJK'; 

>> data 

data = 

ABCDEFGHIJK 

>> x=[ ]; 

>> for c=data 

x=[c x]; 

end 

>> x 

x = 

KJIHGFEDCBA 

x = [ 0:5:100]; 

y = cos(x); 

for k = 1:21 

   x = (k-1)*5; 

   y(k) = cos(x); 

end 
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The find command is another example of an implied loop. The statement 
 
 
is equivalent to  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
If you are familiar with a traditional programming language such as FORTRAN 
or BASIC, you might be included to solve problems in MATLAB using loops, 
instead of using the powerful MATLAB commands such as find. To use these 
commands and to maximize the power of MATLAB, you might need to adopt a 
new approach to problem solving. 

・ Example 

 
 
 
 
 

 

 

 

 

 

 

 

y = find(x>0) 

j = 0; 

for i = 1:length(x) 

   if  x(i) > 0 

      j = j + 1; 

      y(i) = I; 

   end 

end 

Attention! 

if-command is explaned in the
previous section. 

a = 1:10; 

s = sum(a) 

s = 0; 

for  I = 1:10 

   s = s + i; 

end 

s 

Equivalent 

A vector x has been obtained from measurements. Suppose we want to
consider any data value in the range –0.1 < x < 0.1 as being erroneous. We
want to remove all such elements and replace them with zeros at the end of
the array. Develop two ways of doing this. An example is given in the
following able.                   Before  After 

  x(1)  1.92  1.92 
  x(2)  0.05 -2.43 
  x(3) -2.43  0.85 
  x(4) -0.02  0 
  x(5)  0.09  0 
  x(6)  0.85  0 

   x(7) -0.06  0 
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Solution: 

The following script file uses a for loop with conditional statements. Note how 
the null array [ ] is used. 
 
 

 

 

 

 

 

 

 

 

 

The next script file uses the find function. 
 
 
 
 

 

・ while Loops 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

x = [1.92, 0.05, -2.43, -0.02, 0.09, 0.85, 0.06]; 

y = [ ]; z = [ ]; 

for k = 1:length(x) 

   if abs(x(k)) >= 0.1 

       y = [y,x(k)]; 

   else 

       z = [z,x(k)]; 

   end 

end 

xnew = [y, zeros(size(z))] 

x = [1.92, 0.05, -2.43, -0.02, 0.09, 0.85, 0.06]; 

y = x(find(abs(x) >= 0.1)); 

z = zeros(size(find(abs(x) < 0.1))); 

xnew = [y,z] 

The while loop is used when the looping process terminates because a
specified condition is satisfied, and thus the number of passes is not known
in advance. 

Syntax 
while  expression 

     statements 

end 

 

Example 
n=10 

while  n>n 

   a = a + n; 

   n = n – 1; 

end 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
65 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Start of while-loop 

expression 

commands 

Start of while-loop 

while  expression

    commands ... 

end 
True 

False 

>> a=0; 

>> n=10; 

>> while n>0 

a=a+n; 

n=n-1; 

end 

>> a 

a = 

    55 

>> n 

n = 

     0 

Command-base-exec 

MATLAB editor 

(save exwhile.m) 

a=0; 

n=10; 

while n>0 

a=a+n; 

n=n-1; 

end 

Command window 

 

>>exwhile 

>>a 

a= 

     55 

>>n 

n= 

     0 

M-file-base-exec 

>> e=0; EPS=1.0; 

>> while (1+EPS)>1 

     EPS=EPS/2; 

     e=e+1; 

   end 

>> EPS 

EPS = 

  1.1102e-016 

>> e 

e = 

    53 

Calculation of machine-epsilon via
while loop: 
Machine-epsilon  the minimum
quantity which can be dealt by CPU
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● Advantage of Vectorization 

The MATLAB statements are executed once for each element of the row vector or 
column of the matrix. Loops tend to be slow and error prone; instead, wherever possible, 
take advantage of vector and matrix operations like sort, find, any, all, and various 
matrix-addressing operations. Thus, you may try to vectorize statements. 
 
The following example computes logarithms of numbers from 1 to 10,000. We do this in 
different ways for comparison. The commands clock and etime are used to time the 
operation. 
 
 
 
 
 
 
 
 
The first method is a straightforward for loop. In the second method, the index of the 
loop is predefined as a row vector and the loop runs over its columns. In the third 
method, the vector a, which stores the output result, is preallocated. We now see a 
drastic reduction in computation time. The reason for this reduction is that in the 
previous methods, MATLAB has to resize the vector a each time it goes through the 
loop; with preallocation, this step is eliminated. In the forth method, we eliminate the 
for loop and instead use MATLAB’s built-in matrix calculation capabilities (implied 
loops). This is what is meant by vectorization. Again, the reduction in computation time 
is significant. In the last method, we use both vectorization and preallocation. 
 
 
● Summary 

Command Description 
break Terminates the execution of a for or a while loop. 
case Uses with switch to direct program execution. 

continue Passes control to the next iteration of a for or while loop. 
else Delaminates an alternate block of statements. 

elseif Conditionally executes statements. 
end Terminates for, while, and if statements. 

clear, t1 = clock; for i=1:10000, a(i)=log(i); end; e1=etime(clock,t1) 

clear, t1 = clock; ind = [1:10000]; for i=ind, a(i)=log(i); end; e2=etime(clock,t1) 

clear, t1 = clock; a=zeros(1,10000); ind = [1:10000]; ... 

    for i=ind, a(i)=log(i); end; e3=etime(clock,t1) 

clear, t1 = clock; ind = [1:10000]; a=log(ind); e4=etime(clock,t1) 

clear, t1 = clock; a=zeros(1,10000); ind = [1:10000]; a=log(ind);  e5=etime(clock,t1) 
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findstr(‘s1’,’s2’) For character strings s1 and s2, finds the starting indices of any 
occurences of the shorter string within the longer string of the 
pair. 

for Repeats statements a specific number of times. 
if Executes statements conditionally. 

switch Directs program execution by comparing the input expression 
with associated case expressions. 

while Repeats statements an indefinite number of times. 
● Exercise 

Consider the following script M-file. Fill in the lines of the table shown below with the 
values that would be displayed immediately after the while statement if you ran the 
script M-file. Write in the values the variables have each time the while statement is 
executed. You might need more or fewer lines in the table. Then type in the file, ans run 
it to check your answers. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

k = 1; b = -2; x = -1; y = -2; 

while k <= 3 

   k, b, x, y 

   y = x^2 - 3; 

   if y < b 

      b = y; 

   end 

   x = x + 1; 

   k = k + 1; 

end 

Pass k b x Y 

First     

Second     

Third     

Fourth     

Fifth     
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9. Function M-files (in detail), Macros, and Programming Utilities 
● Main difference between script M-files and function M-files 

(1) Function M-files allows parameter passing by values. 
(2) They use local variables and do not operate globally on the workspace. 
(3) The first line of a function M-file must contain the word “function”. 

● Structure 

A function can have multiple input and output arguments. Similar to other MATLAB 
functions, the inputs are placed within parentheses and outputs within square brackets 
(not necessary if there is only one output). After first line, you can include comments for 
documentation purposes. These lines will be displayed when help is requested. All 
variables defined within the body of the function are local, and will be destroyed once 
the function is executed. The only variables passed on to the workspace are the ones 
that are assigned as the function outputs. Local variables in a function will not affect 
the global workspace. Functions can be used like any other MATLAB command.  
For example, you can find the function M-file flipud.m in the directory 
¥MATLABR12¥toolbox¥matlab¥elmat. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

function y = flipud(x) 

%FLIPUD Flip matrix in up/down direction. 

%   FLIPUD(X) returns X with columns preserved and rows flipped 

%   in the up/down direction.  For example, 

%    

%   X = 1 4      becomes  3 6 

%         2 5                     2 5 

%         3 6                    1 4 

% 

%   See also FLIPLR, ROT90, FLIPDIM. 

 

%   Copyright 1984-2000 The MathWorks, Inc. 

%   $Revision: 5.7 $  $Date: 2000/06/16 13:14:45 $ 

 

if ndims(x)~=2, error('X must be a 2-D matrix.'); end 

[m,n] = size(x); 

y = x(m:-1:1,:); 

Header 

Comments 

Body of function 
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● Call and return 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
● Rules and properties 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

function y = flipud(x) 

Input argument 

Output argument 

>> a=[ 1 2 ; 3 4; 5 6]

a = 

     1     2 

     3     4 

     5     6 

>> b=flipud(a); 

>> b 

b = 

     5     6 

     3     4 

     1     2 

call 

return 

(1) The function name and file name are identical. 
(2) When function is called the MATLAB open the corresponding text file and

compile it into internal code. 
(3) Comment lines up to the first non-comment line in a function M-file are help

text. (e.g. flipud.m). 
(4) Each function has its own workspace separate from the MATLAB

workspace (e.g. fact1.m). 
(5) The number of input and output arguments are available nargin, nargout

(e.g. logspace.m).Functions can share variables with other functions by
declaration as global(e.g. toc.m). 

(7) Functions terminate with the end of M-file or return statement. 
(8) The MATLAB function error explains the error, aborts the execution, and

return the control to the keyboard. 
(9) Function M-file may contain more than one function. The first function

statement defines the global function name. The others function statements
defines bfunctions which is locally defined and called by the first function. 
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● Simple example 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Function M-fle 

Save exfun1.m 

function y=exfun1(A,B) 

% matrix calculations 

C=A+B 

D=A-B 

E=A*B 

F=A¥B 

y=‘OK’; 

 

Input argument=A,B 

Output argument=y 

Local variables=C,D,E,F 

Script M-file 

Save exfun2.m 

Q=[1 2 

      3 4]; 

R=[5 6 

      7 8]; 

S=exfun1(Q,R); 

Global variables 

=Q,R,S 

Call by value 

A  Q 

B  R 

Command window >> exfun2 

C = 

      6     8 

    10    12 

D = 

    -4    -4 

    -4    -4 

E = 

    19    22 

    43    50 

F = 

   -3.0000   -4.0000 

    4.0000    5.0000 

>> who 

Your variables are: 

A  B  y   

>> y 

y = 

OK 

Global 

variables 

Local 

variables 
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● Recursive Call 

 
 
 
 
 
 
 
 
 
 
 
 
 
● nargin, nargout 

You can find the function M-file logspace.m in the directory 
¥matlabr12¥toolbox¥matlab¥elmat. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

function y = fact1(n) 

% 

% Example of recursive call 

% 

if n == 1  

    y = 1; 

else 

    y = fact1(n-1)*n; 

end 

Save fact1.m 

>> fact1(3) 

ans = 

     6 

>> fact1(4) 

ans = 

    24 

>> fact1(5) 

ans = 

   120 

command window 

function y = logspace(d1, d2, n) 

%LOGSPACE Logarithmically spaced vector. 

%   LOGSPACE(d1, d2) generates a row vector of 50 logarithmically 

%   equally spaced points between decades 10^d1 and 10^d2.  If d2 

%   is pi, then the points are between 10^d1 and pi. 

%   LOGSPACE(d1, d2, N) generates N points. 

%   See also LINSPACE, :. 

%   Copyright 1984-2000 The MathWorks, Inc.  

%   $Revision: 5.9 $  $Date: 2000/06/01 16:46:52 $ 

if nargin == 2 

    n = 50; 

end 

if d2 == pi 

    d2 = log10(pi); 

end 

y = (10).^ [d1+(0:n-2)*(d2-d1)/(n-1), d2];ｃ 

Case of  
nargin = = 2 

nargin = = 3 

If 3rd argument n is omitted 
n is set as 50 automatically 
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nargin is the number of function input arguments. Inside the body of a user-defined 
function, nargin returns the number of input arguments that were used to call the     
function. nargin('fun') returns the number of declared inputs for the M-file function 'fun'.  
The number of arguments is negative if the function has a variable number of input 
arguments.  
 
nargout is the Number of function output arguments. Inside the body of a user-defined 
function, nargout returns the number of output arguments that were used to call the 
function. nargout('fun') returns the number of declared outputs for the M-file function 
'fun'. The number of arguments is negative if the function has a variable number of 
output arguments. 
 
● Global Declaration 

You can find the function M-file toc.m in the directory 
¥matlabr12¥toolbox¥matlab¥timefun. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

function t = toc 

%TOC Read the stopwatch timer. 

%   TOC, by itself, prints the elapsed time (in seconds) since TIC was used. 

%   t = TOC; saves the elapsed time in t, instead of printing it out. 

% 

%   See also TIC, ETIME, CLOCK, CPUTIME. 

 

%   Copyright 1984-2000 The MathWorks, Inc.  

%   $Revision: 5.9 $  $Date: 2000/06/01 16:09:47 $ 

 

% TOC uses ETIME and the value of CLOCK saved by TIC. 

global TICTOC 

if isempty(TICTOC) 

  error('You must call TIC before calling TOC.'); 

end 

if nargout < 1 

   elapsed_time = etime(clock,TICTOC) 

else 

   t = etime(clock,TICTOC); 

end 

global declaration 
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The global declaration makes variables global in scope, allowing them to be referenced 
inside function M-files without passing them through the argument list. The statement 
 
 
Makes variables x,y, and z global, immediately making them available inside the bodies 
of function M-files. The variable names are separated by spaces, and need not have 
previously existed in the workspace. 
● Text Strings as Macros 

Macros are a short sequence of MATLAB commands that are used often in a session. 
They can be saved for use in future sessions as part of other M-files. Macros are created 
as text strings and are executed using the eval command. eval is a function that works 
with text variables to implement a powerful text macro facility. eval(t) causes the text 
contained in t to be evaluated. If STRING is the source text for any MATLAB expression 
or statement, then 
 
 
encodes the text in t. Typing t prints the text and eval(t) causes the text to be 
interpreted, either as a statement or as a factor in an expression. For example, 
 
 
 
 
 
 

 

generates the Hilbert matrix of order n. Another example showing indexed text, 
 
 
 

 

 

 

 

 

 

 

global  x  y  z 

t = ‘STRING’ 

t = ‘1/(i+j-1)’; 

for  i  =  1:n 

   for  j  = 1:n 

      a(i,j)  =  eval(t); 

   end 

end 

S = [ ‘x = 3           ‘ 

     ‘y = 4           ‘ 

     ‘z = sqrt(x*x+y*y)’]; 

for k = 1:3 

   eval(S(k,:)); 

end 
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● Programing Utilities 

MATLAB has several commands that allow you to make your programs interactive, and 
help with debugging your programs. 

(1) pause stops an M-file until any key is pressed. It is useful after 
plotting commands; pause(n) will pause for n seconds and pause(-2) 
cancels all subsequent pauses. 

(2) echo or echo on or echo off displays the program contents while an 
M-file is being executed. It is a toggle command, so typing echo by 
itself will change the echo state. If echo is on, it affects all script 
M-files; it affects function M-files differently, though. To turn echo on 
for a particular function M-file, use echo filename on; echo on all 
turns it on for all functions. 

(3) keyboard stops an M-file and gives the control to the keyboard. You can 
view and change all variables as you wish. Typing return and pressing 
the return (or ENTER) key allows the M-file to continue. 

(4) The input command displays the text string as a prompt, waits for the 
user to enter a response, evaluates the expression entered by user and 
assigns it to x, e.g., x = input(‘input x_value=’). 

(5) exist(‘item’) checks for the existence of a variable in the workspace for 
a file in MATLAB’s path. 

 
 

10. Data Structure (Cell and Structure Arrays) 
● Cell Arrays 

The cell array is an array in which each element is a bin, or cell, which can contain 
an array. You can store different classes of array in a cell array, and you can group data 
sets that are related but have different dimensions. You access cell arrays using the 
same indexing operations used with ordinary arrays. For example, consider the 
following data: 

A B 
 

[ ]657260  

















535552

555654

565755

 

You can create this array by typing the following either in interactive mode or in a script 
M-file and running it. 
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If you do not yet have contents for a particular cell, you can type a pair of empty braces 
{ } to denote an empty cell, just as a pair of empty brackets [ ] denotes an empty numeric 
array. This notation creates the cell but does not store any contents in it.  
 
To use content indexing, enclose in braces the cell subscripts on the left side using the 
standard array notation. Then specify the cell contents on the right side of the 
assignment operator. 
 
 
 
 
 
Type A at the command line. You will see 
 
 
 
 
You can use the celldisp function to display the full contents. For example, typing 
celldisp(A) displays 
 
 
 
 
 
 
 
 
 
 
 
 

A(1,1) = {‘A’}; 

A(1,2) = {‘B’}; 

A(2,1) = {[60,72,65]}; 

A(2,2) = {[55,57,56;54,56,55;52,55,53]} 

A{1,1} = ‘A’; 

A{1,2} = ‘B’; 

A{2,1} = [60,72,65]; 

A{2,2} = [55,57,56;54,56,55;52,55,53]; 

A =  

  ‘A’           ‘B’ 

  [1x3 double]  [3x3 double] 

A{1,1} =  

A 

A{2,1} =  

60  72  65 

A{1,2} =  

B 

A{2,2} =  

55  57  56 

54  56  55 

52  55  53 
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Function Description 
C = cell(n) Creates an n×n cell array C of empty matrices. 
C = cell(n,m) Creates an n×m cell array C of empty matrices. 
celldisp(C) Displays the contents of cell array C. 
cellplot(C) Displays a graphical representation of the cell array C. 
C = num2cell(A) Converts a numeric array A into a cell array C. 
[X,Y,…] = deal(A,B,…) Matches up the input and output lists. Equivalent to X=A, 

Y=B,… 
[X,Y,…] = deal(A) Matches up the input and output lists. Equivalent to X=A, 

Y=A,… 
iscell(C) Returns a 1 if C is a cell array; otherwise, returns a 0. 
 
● Structure Arrays 

Structure arrays are composed of structures. This class of arrays enables you to 
store dissimilar arrays together. The elements in structures are accessed using named 
fields. This feature distinguishes them from cell arrays, which are accessed using the 
standard array indexing operations. 
 
Suppose you want to create a database of students in a course, and you want to include 
each student’s name, student number, email address, and test scores. The following 
figure shows a diagram of this data structure. 
 
 
 
 
 
 
 
 
 
 
Each type of data is a field, and its name is the field name. Thus our database has 
four fields. The first three fields each contain a text string, while the last field contains 
a vector having numerical elements. A structure consists of all this information for a 
single student. A structure array is an array of such structures for different 
students. 

Structure array “student” 

Student(1) 

・ Name: John Smith 
・ SN: 131285 
・ Email: js@oita.edu 
・ Tests: 55, 60, 85 

Student(2) 

・ Name: Mary Jones 
・ SN: 131286 
・ Email: mj@oita.edu
・ Tests: 85, 90, 85 
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・ Creating Structure 

You can create a structure array by using assignment statements or by using 
the struct function. Structure arrays use the dot notation (.) to specify and to 
access the fields. You can create the structure by typing the following commands 
either in the interactive mode or in a script file. Start with the data for the first 
student. 
 
 
 
 
 
 

 
To determine the size of the array, type size(student). The result is ans = 1  1, 
which indicates that it is a 1x1 structure array. 
To add a second student to the database, use a subscript 2 enclosed in 
parentheses after the structure array’s name and enter the new information. 
 
 
 
 
 
 
 
 
This process “expands” the array. Before we extend the data for the second 
student, the dimension of the structure array was 1x1. Now it is a 1x2 array 
consisting of two structures, arranged in one row and two columns. You can 
confirm this information by typing size(student), which returns ans = 1  2. If 
you now type length(student), you will get the result ans = 2, which indicates 
that the array has two elements. When a structure array has more than one 
structure, MATLAB does not display the individual field contents when you 
type the structure array’s name. You can also obtain information about the field 
by using the fieldnames function. 
 
 

student.name = 'John Smith'; 

student.sn = '131285'; 

student.email = 'js@oita.edu'; 

student.tests = [55,60,85]; 

>> student 

student =  

     name: 'John Smith' 

       sn: '131285' 

    email: 'js@oita.edu' 

    tests: [55 60 85] 

student(2).name = 'Mary Jones'; 

student(2).sn = '131286'; 

student(2).email = 'mj@oita.edu'; 

student(2).tests = [85,80,85]; 

>> student 

student =  

  1x2 struct array with fields:

    name 

    sn 

    email 

    tests 

fieldnames(student) 
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In addition to the assignment statement, you can also build structures using 
the struct function, which lets you “preallocate” a structure array. To build a 
structure array named sa_1, the syntax is 
 
 
In the student database case, we type 
 
 
 

・ Accessing Structure Arrays 

To access the contents of a particular field, type a period after the structure 
array name, followed by the field name. For example, typing student(2).name 
displays the value ‘Mary Jones’. Of course, we can assign the result to a 
variable in the usual way. For example, typing name2 = student(2).name 
assigns the value ‘Mary Jones’ to the variable name2. To access elements 
within a field, for example, John Smith’s second test score, type 
student(1).tests(2). This entry returns the value 75. In general, if a field 
contains an array, you use the array’s subscripts to access its elements. To store 
all the information for a particular structure – say, all the information about 
Mary Jones – in another structure array named M, you type M = student(2). You 
can also assign or change values of field elements. For example, typing 
student(2).tests(2) = 81 changes Mary Jones’s second test score from 78 to 81. 
Direct indexing is usually the best way to create or access field values. However, 
suppose you used the fieldnames function in an M-file to obtain a field name. 
You would know the field name only as a string. In this situation you can use 
the setfield and getfield functions for assigning and retrieving field values. For 
example, typing setfield(M,’name’,’Mary Lee Jones’) inserts the new name. 
Typing getfield(M,’name’) returns the results ans = Mary Lee Jones. 

・ Modifying structures 

Suppose you want to ass phone numbers to the database. You do this by typing 
the first student’s phone number as follows: 
 
 
All the other structures in the array will now have a phone field, but these 
fields will contain the empty array until you give them values. 
To delete a field from every structure in the array, use the rmfield function. Its 

sa_1 = struct(‘filed1’,’value1’,’field2’,’value2’,…) 

student = struct(‘name’, 'John Smith';’sn’, '131285';… 

’email’, 'js@oita.edu',‘tests’, [55,60,85]) 

student(1).phone = ‘554-7777’ 
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basic syntax is 
 
 
where array is the structure array to be modified, ‘field’ is the field to be 
removed, and new_struc is the name of the new structure array so created by 
the removal of the field. For example, to remove the Student Number field and 
call the new structure array new_student, type 
 
 

Functions Description 
names = fieldnames(S) Returns the field names associated with the structure 

array S as names, a cell array of strings. 
F = getfield(S,’field’) Returns the contents of the field ‘field’ in the structure 

array S. Equivalent to F = S.field. 
isfield(S,’field’) Returns 1 if ‘field’ is the name of a field in the 

structure array C, and 0 otherwise. 
isstruct(S) Returns 1 if the array S is a structure array, and 0 

otherwise. 
S = rmfield(S,’field’) Removes the field ‘field’ from the structure array S. 
S = setfield(S,’field’,V) Sets the contents of the field ‘field’ to the value V in the 

structure array S. 
S = struct(‘f1’,’v1’,’f2’,’v2’,…) Creates a structure array with the field ‘f1’,’f2’,… 

having the values ‘v1’,’v2’,… 
 
 
 

 
 
 

New_struc = rmfield(array,’field’); 

new_student = rmfield(student,’SN’); 
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11. Plotting and Model Building 
MATLAB has many functions that are useful for creating plots. In this chapter you will 
learn how to use them to create two-dimensional plots, which are called xy-plots, 
and three-dimensional plots called xyz-plots, or surface plots. These plotting 
functions are described in the graph2d and graph3d help categories, so typing help 

graph2d or help graph3d will display a list of the relevant plotting functions. 
 
An important application of plotting is function discovery, the technique for using 
data plots to obtain a mathematical function or mathematical model that describes the 
process that generated the data. This feature is very useful for engineering applications 
because engineers frequently need to use mathematical models to predict how their 
proposed design will work. A systematic method for obtaining models is regression. 
 
● xy Plotting Functions 

The most common plot is the xy plot. Its name assumes that we are plotting a function y 
= f(x), although other symbols may be used. We plot the x values on the horizontal axis 
(the abscissa), and the y values on the vertical axis (the ordinate). 
 Plot, Label, and Title Commands 

The MATLAB basic xy plotting function is plot(x,y). If x and y are vectors, a single curve 
is plotting with the x values on the abscissa and the y values on the ordinate. The xlabel 

and ylabel commands put labels on the abscissa and the ordinate, respectively. The title 
command puts a title at the top of the plot. For example, 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following script M-file plots y = 0:4
p
1:8x for 0 î x î 52 , where y

represents the height of a rocket after launch, in miles, and x is the horizontal
(downrange) distance in miles. 
 
 x = [0:0.1:52]; 

y = 0.4*sqrt(1.8*x); 

plot(x,y) 

xlabel(‘Distance (miles)’) 

ylabel(‘Height (miles)’) 

title(‘Rocket Height as a Function of Downrange Distance’) 
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When the M-file is executed, the plot shown below appears in the figure window. 

 

You can obtain a hard copy of the plot in one of several ways: 
(1) Use the menu system. Select Print on the File menu in the figure window. 

Answer OK when you are prompted to continue the printing process. 
(2) Type print at the command line. This command sends the current plot 

directly to the printer. 
(3) Save the plot to a file to be printed later or imported into another 

application such as a word processor. You need to know something about 
graphics file formats to use this file properly. 

If you type help print, you obtain the following information on the print command. 
      print  

PRINT alone sends the current figure to your current printer. The size and 
position of the printed output depends on the figure's PaperPosition[mode] 
properties and your default print command as specified in your PRINTOPT.M 
file. 

      print -s 

        Same as above but prints the current Simulink model. 
      print -device -options  

You can optionally specify a print device (i.e., an output format such as tiff or 
PostScript or a print driver that controls what is sent to your printer) and 
options that control various characteristics of the printed file (i.e., the 
resolution, the figure to print etc.). Available devices and options are described 
below. 

      print -device -options filename 

If you specify a filename, MATLAB directs output to a file instead of a printer. 

xlabel

ylabel

title 
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PRINT adds the appropriate file extension if you do not specify one. 
COMMON DEVICE DRIVERS 
Output format is specified by the device driver input argument. This argument 
always starts with '-d' and falls into one of several categories: 
Microsoft Windows system device driver options: 

        -dwin      % Send figure to current printer in monochrome 
        -dwinc     % Send figure to current printer in color 
        -dmeta     % Send figure to clipboard in Metafile format 
        -dbitmap   % Send figure to clipboard in bitmap format 
        -dsetup    % Bring up Print Setup dialog box, but do not print 

-v         % Verbose mode, bring up the Print dialog box which is normally 
suppressed. 

Built-in MATLAB Drivers: 
        -dps       % PostScript for black and white printers 
        -dpsc      % PostScript for color printers 
        -dps2      % Level 2 PostScript for black and white printers 
        -dpsc2     % Level 2 PostScript for color printers 
        -deps      % Encapsulated PostScript  
        -depsc     % Encapsulated Color PostScript 
        -deps2     % Encapsulated Level 2 PostScript 
        -depsc2    % Encapsulated Level 2 Color PostScript 
        -dhpgl     % HPGL compatible with Hewlett-Packard 7475A plotter 
        -dill        % Adobe Illustrator 88 compatible illustration file 
        -djpeg<nn> % JPEG image, quality level of nn (figures only) 
                     e.g., -djpeg90 gives a quality level of 90.  
                     Quality level defaults to 75 if nn is omitted. 
        -dtiff     % TIFF with packbits (lossless run-length encoding) 
                     compression (figures only) 
        -dtiffnocompression % TIFF without compression (figures only) 
        -dpng      % Portable Network Graphic 24-bit truecolor image (figures only) 

Other output formats are possible by using the GhostScript application 
supplied with MATLAB. For a full listing see the online help for 
GHOSTSCRIPT, use the command 'help private/ghostscript'. 
An example of some of the device drivers supported via GhostScript are: 

        -dljet2p   % HP LaserJet IIP 
        -dljet3    % HP LaserJet III 
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        -ddeskjet  % HP DeskJet and DeskJet Plus 
        -dcdj550   % HP Deskjet 550C (UNIX only) 
        -dpaintjet  % HP PaintJet color printer 
        -dpcx24b   % 24-bit color PCX file format, 3 8-bit planes 
        -dppm      % Portable Pixmap (plain format) 

PRINTING OPTIONS 
Options only for use with PostScript and GhostScript drivers: 

        -loose      % Use Figure's PaperPosition as PostScript BoundingBox 
        -append    % Append, not overwrite, the graph to PostScript file 
        -tiff        % Add TIFF preview, EPS files only (implies -loose) 
        -cmyk      % Use CMYK colors instead of RGB 

-adobecset % Use Adobe PostScript standard character set encoding Options 
for PostScript, GhostScript, Tiff, Jpeg, and Metafile: 

-r<number> % Dots-per-inch resolution. Defaults to 90 for Simulink, 150 for 
figures in image formats and when printing in Z-buffer or OpenGL mode, 
screen resolution for Metafiles and 864 otherwise. Use -r0 to specify screen 
resolution. 
Example: 

        print -depsc -tiff -r300 matilda  

Saves current Figure at 300 dpi in color EPS to matilda.eps with a TIFF 
preview (always at 72 dpi). This TIFF preview will show up on screen if 
matilda.eps is Inserted as a Picture in a Word document, but the EPS will be 
used if the Word document is printed on a PostScript printer. 

 Grid and axis Commands 

The grid command displays gridlines at the tick marks corresponding to the tick labels. 
Type grid on to add gridlines; type grid off to stop plotting gridlines. When used by 
itself, grid toggles this feature on or off, but you might want to use grid on and grid off 
to be sure. You can use axis command to override the MATLAB selections for axis limits.  
 
 
・example 
 
 
 
 
 

axis([xmin xmax ymin ymax]) 

x = [0:0.1:52]; 

y = 0.4*sqrt(1.8*x); 

plot(x,y), xlabel(‘Distance (miles)’), ylabel(‘Height (miles)’) 

title(‘Rocket Height as a Function of Downrange Distance’) 

grid on, axis([0  52  0  5]) 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
84 

 

 
 
 Plots of Complex Numbers 

With only one argument, say, plot(y), the plot function will plot the values in the vector 
y versus their indices 1,2,3,…, and so on. If y is complex, plot(y) plots the imaginary 
parts versus the real parts. Thus plot(y) in this case is equivalent to 
plot(real(y),imag(y)), e.g., 
 
 
 
 
 
 
 
 
 
 Function Plot Command fplot 

MATLAB has a “smart” command for plotting functions. The fplot command 
automatically analyzes the function to be plotted and decides how many plotting points 
to use so that the plot will show all the features of the function. The syntax is 
 
 
where is ‘string’ a text string that describes the function to be plotted and [xmin  

xmax] specifies the minimum and maximum values of the independent variable (x-axis). 
The range of the dependent variable (y-axis) can also be specified. In this case the 

gridlines 

xmax 
xmin 

ymin 

ymax 

z = 0.1 + 0.9i; 

n = [0 : 0.01 : 50]; 

plot(z.^n) 

xlabel(‘Real’) 

ylabel(‘Imaginary’) 

fplot(‘string’, [xmin  xmax]) 
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syntax is 
 
 
Example (comparison between the fplot and plot commands) 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 Plotting Polynomials 

We can plot polynomials more easily by using the polyval function. This function 
evaluates the polynomial at specified values of the independent variable. For example, 
 
 
 
 
 
 
 
 
 
 Subplots 

You can use the subplot command to obtain several smaller “subplots” in the same 
figure. The syntax is 
 
 
This command divides the figure window into an array of rectangular panes with m 

fplot(‘string’, [xmin  xmax]) 

f = 'cos(tan(x))-tan(sin(x))'; 

fplot(f,[1 2]) 
x = [1:0.01:2]; 

y = cos(tan(x))-tan(sin(x)); 

plot(x,y) 

x = [-10:0.01:10]; 

p = [1 2 1]; 

plot(x,polyval(p,x)),xlabel(‘x’),ylabel(‘p’) 

Subplot(m,n,p) 
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rows and n columns. The variable p tells MATLAB to place the output of the plot 
command following the subplot command into the pth panes. For example, 
 
 
 
 
 
 
 
 
 
 
 
 Overlay Plots 

You can use the following variants of the MATLAB basic plotting function plot(x,y) and 
plot(y) to create plots: 

(1) plot(A) plots the columns of A versus their indices and generates n curves 
where A is a matrix with m rows and n columns. 

(2) plot(x,A) plots the matrix A versus the vector x, where x is either a row vector 
or column vector and A is a matrix with m rows and n columns. If the length of 
x is m, then each column of A is plotted versus the vector x. If x has length n, 
then each row of A is plotted versus the vector x. 

(3) plot(A,x) plots the vector x versus the matrix A. If the length if x is m, then x is 
plotted versus the column of A. If the length of x is n, then x plotted versus the 
row of A. 

(4) plot(A,B) plots the columns of the matrix B versus the columns of the matrix 
A. 

For example, 
 
 
 
 
 
 
 
 

x = [0 : 0.01 : 5]; 

y = exp(-1.2*x).*sin(10*x+5); 

subplot(1,2,1) 

plot(x,y),xlabel('x'),ylabel('y'), 

axis([0 5 -1 1]) 

x = [-6 : 0.01 : 6]; 

y = abs(x.^3-100); 

subplot(1,2,2) 

plot(x,y),xlabel('x'),ylabel('y'), 

axis([-6 6 0 350]) 

x = [0:0.01:2]'; 

A = [x, x.^2, x.^3 ]; 

B = [sin(x), cos(x), sin(x).*cos(x)]; 

subplot(2,2,1), plot(A) 

subplot(2,2,2), plot(x,A) 

subplot(2,2,3), plot(A,x) 

subplot(2,2,4), plot(A,B) 
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 Data Marker and Line Types 

To plot the vector y versus the vector x and mark each point with a data marker, enclose 
the symbol for the marker in single quotes in the plot function. 
 
 
To connect each data marker with a straight line, we must plot the data twice, by typing  
 
 
Suppose we have two curves or data sets stored in the vectors x,y,u, and v. To plot y 
versus x and v versus u on the same plot, type  
 
 
Both sets will be plotted with a solid line, which is default line style. To distinguish the 
sets, we can plot them with different line types. To plot y versus x with a solid line and v 
versus u with a green dashed line, type 
 
 
Specifiers for data markers, line types, and colors are as follows: 

Data markers Line types Colors 
. (Dot) - Solid line k Black 
* (Asterisk) - - Dashed line b Blue 
x (Cross) -. Dashed-dotted line c Cyan 
o (Circle) : Dotted line g Green 
+ (Plus sign)   m Magenta 
s (Square)   r Red 
d (Diamond)   w White 
p (Five-point star)   y Yellow 
 Labeling Curves and Data 

When more than one curve or data set is plotted on a graph, we must distinguish 
between them. If we use different data symbols or different line types, then we must 
either provide a legend or place a label next to each curve. To create a legend, use the 
legend command. The syntax is 
 
 
Where string1 and string2 are text strings of your choice. The legend command 
automatically obtains from the plot the line type used for each data and displays a 

plot(x,y,’data marker’)  e.g., plot(x,y,’o’) 

plot(x,y,x,y,’o’) 

plot(x,y,u,v) 

plot(x,y,u,v,’g- -‘) 

legend(‘string’,’string’) 
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sample of this line in the legend box next to the string you selected. For example, 
 
 
 
 
 
 
 
 
 
Another way to distinguish curves is to place a label next to each. The label can be 
generated with either the gtext command, which lets you place the label using the 
mouse, or with the text command. The text command adds a text string to the plot at the 
location specified by the coordinates x,y. 
 
 
 
 
 The hold command 

The hold command creates a plot that needs two or more plot commands. For example, 
 
 
 
 
 
 
 
 
 
 
● Logarithmic Plots 

Logarithmic scales are also widely used. Two common reasons for choosing a log scale 
are (1) to represent a data set that covers a wide range of values and (2) to identify 
certain trends in data. MATLAB has three commands for generating plots having log 
scales. The appropriate command depends on which axis must have a log scale. 

(1) Use the loglog(x,y) command to have both scales logarithmic. 

gtext(‘string’) 

text(x,y,’string’) 

x = [-1 : 0.01 : 50]; 

y = [0: 0.01 : 100]; 

a = 0.1 + 0.2i; 

b = -0.5 + 0.6i; 

plot(a.^x), hold, plot(b.^y,'--r') 

x = [0:0.1:2*pi]; 

y = sin(x); 

z = cos(x); 

plot(x,y,x,z,'o') 

xlabel('x'),ylabel('Sin and Cos') 

legend('sin(x)','cos(x)') 
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(2) Use the semilogx(x,y) command to have the x scale logarithmic and the y 
scale rectilinear. 

(3) Use the semilogy(x,y) command to have the y scale logarithmic and the x 
scale rectilinear. 

For example, 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
● Controlling Tick-Mark Spacing and Labels 

The MATLAB set command is a powerful command for changing the properties of 
MATLAB “objects”, such as plots. We will show how to use it to specify the spacing and 
labels of the tick marks. To explore this command further, type help set and help axes. 
Many of the properties that affect the appearance of plot axes are described under the 
axes command, which should not be confused with the axis command. We can use the 
following command to specify a proper tick-mark spacing. 
 
 
xmin and xmax are the x values that specify the placement of the first and the last tick 
marks on the x-axis, and dx specifies the spacing between tick marks. You would 
normally use the same values for xmin and xmax in both the set and axis commands. 

x = [1, 1.5, 2, 2.5, 3, 3.5, 4]; 

y1 = [4, 3.16, 2.67, 2.34, 2.1, 1.92, 1.78]; 

y2 = [8.83, 7.02, 5.57, 4.43, 3.52, 2.8, 2.22]; 

subplot(2,2,1) 

plot(x,y1,x,y1,'o',x,y2,x,y2,'x') 

xlabel('x'),ylabel('y') 

axis([1 4 0 10]) 

subplot(2,2,2) 

semilogy(x,y1,x,y1,'o',x,y2,x,y2,'x') 

xlabel('x'),ylabel('y') 

subplot(2,2,3) 

semilogx(x,y1,x,y1,'o',x,y2,x,y2,'x') 

xlabel('x'),ylabel('y') 

subplot(2,2,4) 

loglog(x,y1,x,y1,'o',x,y2,x,y2,'x') 

xlabel('x'),ylabel('y') 

axis([1 4 1 10]) 

 

set(gca, ‘XTick’, [xmin:dx:xmax], ‘YTick’, [ymin:dy:ymax]) 
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Similar definitions apply to the y axis value ymin, ymax, and dy. The term gca stands 
for “get current axes”. It tells MATLAB to apply the new values to the axes currently 
used for plotting. For example, to plot y = 0.25x2 for 0≦x≦2, with tick marks spaced at 
intervals of 0.2 on the x-axis and 0.1 on the y-axis, you use the following script M-file: 
 
 
 
 
 

 

 

You can also use the Plot Editor to change the tick spacing. The set command can 
also be used to change the tick-mark labels, for example, from numbers to text, e.g., 
 
 
 

 

 

 

 

 

 

● Stem, Stairs, and Bar Plots 

MATLAB has several other plot types that are related to xy plots. These include the 
stem, stairs, and bar plots. 
 
 
 
 

 

x = [0:0.01:2]; 

y = 0.25*x.^2; 

plot(x,y) 

set(gca,'XTcik',[0:0.2:2],'YTick',[0:0.1:1]) 

xlabel('x'),ylabel('y') 

x = [1:6]; 

y = [13, 5, 7, 14, 10, 12]; 

plot(x,y,'o',x,y) 

set(gca,'XTicklabel',['Jan';'Feb';'Mar';'Apr';'May';'Jun']) 

set(gca,'XTick',[1:6]) 

xaxis([1 6 0 15]) 

xlabel('Month'),ylabel('Monthly Sales(¥1000)') 

title('Sales for January to June') 

x = [1:6]; 

y = [13, 5, 7, 14, 10, 12]; 

stem(x,y) 

x = [1:6]; 

y = [13, 5, 7, 14, 10, 12]; 

stairs(x,y) 

x = [1:6]; 

y = [13, 5, 7, 14, 10, 12]; 

bar(x,y) 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
91 

● Separate Y Axes 

The plotyy function generates a graph with two y axes. The syntax is 
plotyy(x1,y1,x2,y2) plots y1 versus x1 with y-axis labeling on the left, and plots y2 
versus x2 with y-axis labeling on the right. The syntax 
plotyy(x1,y1,x2,y2,’type1’,’type2’) generates a ’type1’ plot of y1 versus x1 with y-axis 
labeling on the left, and generates a ’type2’ plot of y2 versus x2 with y-axis labeling on 
the right. 
● Polar Plots 

Polar plots are two-dimensional plots made using polar coordinates. If the polar 
coordinates are (θ,r), where θ is the angular coordinate and r is the radial coordinate 
of the point, then the command polar(theta,r) will produce the polar plot. A grid is 
automatically overlaid on a polar plot. 
For example, 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

theta = [0:pi/90:2*pi]; 

r = 2.0/(1-0.5*cos(theta)); 

polar(theta,r) 

title(‘Polar plot’) 
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● The Plot Editor 

After creating a plot, you can make changes to it and annotate it with the Plot Editor, 
which is an easy-to-use graphical interface. You operate the Plot Editor from the Figure 
window, which has seven menus. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 The File menu is used for saving and printing the figure. To save it using a 

particular graphics format, such as TIFF, for use with other applications, select 
Export from the File menu. 
 You can use the Edit menu to cut, copy, and paste items, such as legend or title text, 

that appear in the figure. Use the Copy Figure item to copy the figure to the 
clipboard. You can then paste the figure into another program, such as a paint or 
slide show program. Use the Copy Options to select the graphics format used for 
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copying. For example, when you select the Copy Figure item, you get the following 
image data on the clipboard: 

 
 
 
 
 
 
 
 
 
 

The Figure Properties is used to change the style of the Figure window. The Figure 

Properties is used to change the style of the Figure window.  
 
 
 
 
 
 
 
 
 
 
 
 

The last two items on the Edit menu are very useful for editing the figure. Clicking 
the Axes Properties item brings up a dialog box.  
 

Select tab 
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If you click on the Scale tab, the box looks something like the following window: 
 

 
 
 
 
 
 
 
 
 
 
 
Double-clicking on any axis also bring up this box. You can turn off the MATLAB 
automatic selection of limits, ticks, and labels by clicking on the checked box next to 
the appropriate item. When the check mark disappears, you can enter your own 
values. 
 The View menu lets you select which ones you want to appear. 
 The Inset menu enables you to insert labels, legends, titles, and text, rather than 

using the relevant commands from the Command windows. 
 

Axes properties 

Edit 

Scale Style Labels Aspect Light Viewpoint Info 

Cancel Apply Help 

Scale 
Grid Set axes auto shapes 

Set tight limits 
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 The Tool menu reproduces the zoom and rotate functions on the Figure toolbar. 
 The Window menu lets you switch between the Command window and any other 

Figure windows. 
● Summary (commands) 

Basic xy plotting commands 
Command Description 

axis([xmin xmax ymin ymax]) Sets the minimum and maximum limits of the x- and 
y-axes. 

fplot(‘string’,[xmin,xmax]) Performs intelligent plotting of functions, where 
‘string’ is a text string that describes the function to be 
plotted and [xmin xmax] specifies the minimum and 
maximum values of the independent variables. The 
range of the dependent variable can also be specified. 
In this case the syntax is fplot(‘string’,[xmin xmax 
ymin ymax]). 

grid Displays gridlines at the tick marks corresponding to 
the tick labels. Type grid on to add gridlines; type grid 

off to stop plotting gridlines. When used by itself, grid 
switches this feature on or off. 

plot(x,y) Generates a plot of the array y versus the array x on 
rectilinear axes. 

Insert 
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plot(y) Plots the values of y versus their indices if y is vector. 
Plots the imaginary parts of y versus the real parts if y 
is a vector having complex values. 

print Prints the plot in the figure window. 
title(‘text’) Puts text in a title at the top of a plot. 
xlabel(‘text’) Adds a text label to the x-axis (the abscissa). 
ylabel(‘text’) Adds a text label to the y-axis (the ordinate). 
Plot enhancement commands 

Command Description 
axes Creates axes objects. 
gtext(‘text’) Places the string text in the figure window at a point 

specified by the mouse. 
hold Freezes the current plot for subsequent graphics 

commands. 
legend(‘leg1’,’leg2’, …) Creates a legend using the strings leg1, leg2, and so on 

and specifies its placement with the mouse. 
plot(x,y,u,v) Plots, on the rectilinear axes, four arrays; y versus x 

and v versus u. 
plot(x,y,’type’) Plots the array y versus the array x on rectilinear axes, 

using the line type, data marker, and colors specified in 
the string type. 

plot(A) Plots the columns of the m×n array A versus their 
indices and generates n curves. 

plot(P.Q) Plots array Q versus array P. 
refresh Redraws the current figure window. 
subplot(m,n,p) Splits the figure window into an array of subwindows 

with m rows and n columns and directs the subsequent 
plotting commands to the pth subwindow. 

text(x,y,’text’) Places the string text in the figure window at a point 
specified by coordinates x,y. 

Specialized plot command 
Command Description 

bar(x,y) Creates a bar chart of y versus x. 
loglog(x,y) Produces a log-log plot of y versus x. 
polar(theta,r,’type’) Produces a polar plot from the polar coordinates theta 
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and r, using the line type, data marker, and colors 
specified in the string type. 

semilogx(x,y) Produces a semilog plot of y versus x with logarithmic 
abscissa scale. 

semilogy(x,y) Produces a semilog plot of y versus x with logarithmic 
ordinate scale. 

stairs(x,y) Produces a stairs plot of y versus x. 
stem(x,y) Produces a stem plot of y versus x. 
 
● Function Discovery 

Function discovery is the process of finding a function that can describe a particular set 
of data. The following three function types can often describe physical phenomena. 

(1) The linear function : y(x) = mx + b. 
(2) The power function : y(x) = bxm. 
(3) The exponential function : y(x) = b(10)mx 

or its equivalent form: y = bemx 
where e is the basis of the natural logarithm (ln e = 1). 

Each function gives a straight line when plotted using a specific set of axes: 
(1) The linear function y(x) = mx + b gives a straight line when plotted on 

rectilinear axes. Its slope is m and its intercept is b. 
(2) The power function y(x) = bxm gives a straight line when plotted on 

log-log axes. 
(3) The exponential function y(x) = b(10)mx and its equivalent form y = bemx 

give a straight line when plotted on a scaling plot whose y-axis is 
logarithmic. 

We can find the values of b and m with the MATLAB polyfit function. This function 
finds the coefficients of a polynomial of specified degree n that best fits the data, in the 
so-called least square sense. 

Command Description 
p = polyfit(x,y,n) Fits a polynomial of degree n to data described by the vectors x and 

y, where x is the independent variable. Returns a row vector p of 
length n+1 that contains the polynomial coefficients in order of 
descending powers. 

We can use the polyfit function for each case as follows: 
(1) The linear function y(x) = mx + b  p = polyfit(x,y,1) 
(2) The power function y(x) = bxm  p = polyfit(log10(x),log10(y),1) 
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(3) The exponential function y(x) = b(10)mx  p = polyfit(x,log10(y),1) 
・Example 
 
 
 
 
 
 
 
 
 
 
Because T(0) is finite but nonzero, the power function cannot describe this data, so we 
do not bother to plot the data log-log axes. Common sense tells us that the coffee will 
cool and its temperature will eventually equal the room temperature. So we subtract 
the room temperature from the data and plot the relative temperature, T - 68, versus 
time. If the relative temperature is a linear function of time, the model is 

T – 68 = mt + b 
If the relative temperature is an exponential function of time, the model is 

T – 68 = b(10)mt 
The script M-file 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The temperature of coffee cooling in a porcelain mug at room temperature (68°F) was
measured at various times. The data follows. 
           Time t (sec)     Temperature T(°F) 

0  145 
620  130 
2266  103 

  3482   90 
Develop a model of the coffee’s temperatures as a function of time and use the model to
estimate how long it will take the temperature to reach 120(°F). 

% Enter the data. 

time = [0,620,2266,3482]; 

temp = [145,130,103,90]; 

%Subtract the room temperature. 

temp = temp – 68; 

%Plot the data on rectilinear scales 

subplot(1,2,1) 

plot(time,temp,time,temp,’o’) 

xlabel(‘Time (sec)’),ylabel(‘Relative Temperature (deg F)’) 

%Plot the data on semilog scales. 

subplot(1,2,2) 

semilogy(time.temp,time,temp,’o’) 

xlabel(‘Time (sec)’),ylabel(‘Relative Temperature (deg F)’) 
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generates the following plots. 
 
 
 
 
 
 
 
 
 
 
 
The data forms a straight line on the semilog plot only. Thus it can be described with the 
exponential function T = 68 + b(10)mt. Using the polyfit command, the following lines 
can be added to the script file. 
 
 
 
 
The computed values are m = -1.5557×10-4 and b = 77.4469. Thus our derived model is 
T = 68 + b(10)mt . To estimate how long it will take for the coffee to cool to 120°F, we 
must solve the equation 120 = T = 68 + b(10)mt for t. The solution is  

t = [(log10(120-68)-log10b)]/m. 
The MATLAB command for this calculation is shown in the following script M-file, 
which produces the next plots. 
 
 
 
 
 
 
 
 
 
 
 

% Fit a straight line to the transformed data. 

p = polyfit(time,log10(temp),1); 

m = p(1), b = 10^p(2) 

% Compute the time to reach 120 degrees. 

t_120 = (log10(120-68)-log10(b))/m 

% Show the derived curve and estimated point on semilog scales. 

t = [0:10:4000]; 

T = 68+b*10.^(m*t); 

subplot(1,2,1),semilogy(t,T-68,time,temp,’o’,t_120,120-68,’+’) 

xlabel(‘Time (sec)’),ylabel(‘Relative Temperature (deg F)’) 

%Show the derived curve and estimated point. 

subplot(1,2,2),plot(t,T,time,temp+68,’o’,t_120,120,’+’) 

xlabel(‘Time (sec)’),ylabel(‘Temperature (deg F)’) 
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The computed value of t_120 is 1112. Thus the time to reach 120°F is 1112 seconds. 
 
 
 
 
 
 
 
 
 
 
 
・Remarks on Interpolation and Extrapolation 
After we discover a functional relation that describes the data, we can use it to predict 
conditions that lie within the range of the original data. This process is called 
interpolation. Extrapolation is the process of using the model to predict 
conditions that lie outside the original data range. We must be careful when using 
extrapolation because we often have no reason to believe that the mathematical model 
is valid beyond the range of the original data. 
● Regression 

We can distinguish between two types of analysis in experiments involving two 
variables, say, x and y.  
(1) In the first type, called correlation analysis, both variables are random, and 

we are interested in finding the relation between them.  
(2) With the second type of analysis, called regression, one of the variables, say, x, is 

regarded as an ordinary variable because we can measure it without error or assign 
it whatever values we want. The variable y is a random variable. Regression 
analysis deals with the relationship between y and x. 

The MATLAB function polyfit allows you to perform regression analysis with functions 
that are linear or could be converted to linear form by a logarithmic or other 
transformation. The polyfit function is based on the least squares method. 
 The Least Squares Method 

Supposed that we have the M data points given by (xi,yi),i=1,…,M and we need to 
approximate the data curve with the polynomial function 

y(x) = a1xn + a2xnÄ1 + ÅÅÅ+ anx + an+1  
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The least square method is to find the n+1 coefficients ai that minimize the following 
performance index J, the sum of the squares of the vertical differences between the 
curve of the polynomial function and the data points. 

J =
PM
i=1(a1x

n + a2xnÄ1 +ÅÅÅ+ anx+ an+1 Ä yi)2 

The values of the n+1 coefficients can be found by solving a set of n+1 linear equations. 
The polyfit function provides this solution. Its syntax is 
 
 
The following example finds and plots the first- through fourth-degree polynomials for 
given data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

p = polyfit(x,y,n) 

x = [1:9]; 

y = [5,6,10,20,28,33,34,36,42]; 

xp = [1: 0.01:9]; 

for k = 1:4 

    coeff = polyfit(x,y,k) 

    yp(k,:) = polyval(coeff,xp); 

    J(k) = sum((polyval(coeff,x)-y).^2); 

end 

subplot(2,2,1) 

plot(xp,yp(1,:),x,y,'o'),axis([0 10 0 50]) 

subplot(2,2,2) 

plot(xp,yp(2,:),x,y,'o'),axis([0 10 0 50]) 

subplot(2,2,3) 

plot(xp,yp(3,:),x,y,'o'),axis([0 10 0 50]) 

subplot(2,2,4) 

plot(xp,yp(4,:),x,y,'o'),axis([0 10 0 50]) 

J 

coeff = 

  4.9833  -1.1389 

 

coeff = 

  -0.2197  7.1803  -5.1667 

 

coeff = 

  -0.1019  1.3081  0.7433  1.5556 

 

coeff = 

  0.0795  -1.6928  11.9331  

-25.9613  21.0556 

 

J = 

  71.5389  56.6727  41.8838  4.6566 
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 Scaling the Data 

The effect of computational errors in computing the coefficients can be lessened by 
properly scaling the x values. When the function polyfit(x,y,n) is executed, it will issue a 
warning message if the polynomial degree n is greater that or equal to the number of 
data points, or if the vector x has repeated, or nearly repeated, points, or if the vector x 
needs centering and/or scaling. The alternative syntax  
 
 
finds the coefficients p of a polynomial of degree n in terms of the variable 

x̂ = (xÄñx)
õx  

The output variable mu is a two-element vector, [μx,σx], where μx is the mean of x, 
and σx is the standard deviation of x. You can scale the data yourself before using 
polyfit. Some common scaling methods are 

x̂ = xÄ xmin or x̂ = xÄñx 
if the range of x is small, or 

x̂ = x
xmax

or x̂ = x
xmean 

if the range of x is large. 
 Constraining Models to Pass through a Given Point 

Many applications require a model whose form is dictated by physical principles. For 
example, the force-extension model of a spring must pass through the origin (0,0) 
because the spring exerts no force when it is unstretched. Thus a linear spring model f = 
a1x + a2 must have a zero value for a2. However, in general the polyfit function will give 
a nonzero value for a2 because of the scatter or measurement error that is usually 
present in the data. 
・ Multiple Linear Regression 

Suppose that y is a linear function of two or more variables, x1,x2,…. For example, 
y = a0 + a1x1 + a2x2  

To find the coefficient values a0,a1, and a2 to fit a set of data (y,x1,x2) in the least 
squares sense, we can make use of the fact that the left-division method for solving 
linear equations uses the least squares method when the equation set is 
overdetermined. To use this method, let n be the number of data points and write 
the linear equation in matrix form as follows. 

Xa = y  
where 

[p,s,mu] = polyfit(x,y,n) 
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a =

264 a0

a1

a2

375 ; y =

266664
y1

y2
...

yn

377775 ; X =

266664
1 x11 x21

1 x12 x22
...

...
...

1 x1n x2n

377775
 

The solution for the coefficients is given by  
 

 
 Summary (commands) 

Command Description 
p = polyfit(x,y,n) Fits a polynomial of degree n to data described by the 

vectors x and y, where x is the independent variable. 
Returns a row vector p of length n+1 that contains the 
polynomial coefficients in order of descending powers. 

[p,s,mu] = polyfit(x,y,n) Fits a polynomial of degree n to data described by the 
vectors x and y, where x is the independent variable. 
Returns a row vector p of length n+1 that contains the 
polynomial coefficients in order of descending powers 
and a structure s for use with polyval to obtain error 
estimates for predictions. The optional output variable 
mu is a two-element vector containing the mean and 
standard deviation of x. 

[y,delta] = polyval(p,x,s,mu) Uses the optional structure s generated by [p,s,mu] = 

polyfit(x,y,n) to generate error estimates. If the error in 
the data used with polyfit are independent and normally 
distributed with constant variance, at least 50 percent of 
the data will lie within the band y±delta. 

● The Basic Fitting Interface 

MATLAB supports curve fitting through the Basic Fitting interface. Using this interface, 
you can quickly perform basic curve fitting tasks within the same easy-to-use 
environment. The interface is designed so that you can: 
(1) Fit data using a cubic Spline or a polynomial up to degree 10. 
(2) Plot multiple fits simultaneously for a given data set. 
(3) Plot the residuals. 
(4) Examine the numerical results of a fit. 
(5) Interpolate or extrapolate a fit. 

a = X¥y 
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(6) Annotate the plot with the numerical fit results and the norm of residuals. 
(7) Save the fit and evaluated results to the MATLAB workspace. 
Note! You can use the Basic Fitting interface only with two-dimensional data. However, 
if you plot multiple data sets as a subplot, and at least one data set is two-dimensional, 
then the interface is enabled. To use the Basic Fitting interface, perform as follows: 
(1) Plot some data 
(2) Select Basic Fitting from the Tools menu. 
 
 
 
 
 
 
 
 
 
 
 
 
(3) Click the More button once. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Subplot 

Select Data 

6th order polynomial 

Significant digits

Plot Residuals 
Select Data 

Show Norm of Residuals 

More 

spline 

Hermite interpolation 

linear 
quadratic 

cubic 

Help 

Close 
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We omit the details, please try the interface directly. 
● Three Dimensional Plots 

Functions of two variables are sometimes difficult to visualize with a two-dimensional 
plot. Fortunately, MATLAB provides many functions for creating three-dimensional 
plots. Here will summarize the basic functions to create three types of plots: line plots, 
surface plots, and contour plots. 
 Three-Dimensional Line Plots 

Lines in three-dimensional space can be plotted with the plot3 function. Its syntax is 
 
 
For example, 
 
 
 
 
 
 
 
 
 
 
 
 
 

Numerical Resuls 

Fit 

Coefficients & Norm Residuals 

Save to Workspace 

plot3(x,y,z) 

t = [0:pi/50:10*pi]; 

x = exp(-0.05*t).*sin(t); 

y = exp(-0.05*t).*cos(t); 

z = t; 

plot3(x,y,z) 

xlabel('x') 

ylabel('y') 

zlabel('z') 

grid 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
106 

 Surface Mesh Plots 

The function z = f(x,y) represents a surface when plotted on xyz axis, the mesh function 
provides the means to generate a surface plot. Before you can use this function, you 
must generate a grid of points in the xy plane, and then evaluate the function f(x,y) at 
these points. The meshgrid function generates the grid. Its syntax is 
 
 
If x = [xmin:xspacing:xmax] and y=[ymin:yspacing:ymax], then this function will 
generate the coordinates of a rectangular grid with one corner at (xmin,ymin) and the 
opposite corner at (xmax,ymax). Each rectangular panel in the grid will have a width 
equal to xspacing and a depth equal to yspacing. The resulting matrices X and Y 
contain the coordinate pairs of every point in the grid. These pairs are then used to 
evaluate the function. 
 
The function [X,Y] = meshgrid(x) is equivalent to [X,Y] = meshgrid(x,x) and can be used 
if x and y have the same minimum values, the same maximum values, and the same 
spacing. Using this form, you can type [X,Y] = meshgrid(min:spacing:max), where min 
and max specify the minimum and maximum values of both x and y and spacing is the 
desired spacing of the x and y values. 
 
After the grid is computed, you create the surface plot with the mesh function. Its 
syntax is 
 
 
The grid, label, and text functions can be used with the mesh function. For example, 
 
 
 
 
 
 
 
 
 
 
 

[X,Y] = meshgrid(x,y) 

mesh(x,y,z) 

[X,Y] = meshgrid(-2:0.1:2); 

Z = X.*exp(-((X-Y.^2).^2 + Y.^2)); 

mesh(X,Y,Z) 

xlabel('x') 

ylabel('y') 

zlabel('z') 
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 Contour Plots 

Topographic plots show the contours of the land by means of constant elevation lines. 
These lines are also called contour lines, and such a plot is called a contour plot. Its 
syntax is 
 
 
For example, 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command Description 
contour(x,y,z) Creates a contour plot. 
mesh(x,y,z) Creates a three-dimensional mesh surface plot. 
meshc(x,y,z) Same as mesh but draws a contour plot under the surface. 
meshz(x,y,z) Same as mesh but draws a series of vertical reference lines 

under the surface. 
surf(x,y,z) Creates a shaded three-dimensional mesh surface plot. 
surfc(x,y,z) Same as surf but draws a contour plot under the surface. 
[X,Y]=meshgrid(x,y) Create the matrices X and Y from the vectors x and y to define a 

rectangular rid. 
[X,Y]=meshgrid(x) Same as [X,Y]=meshgrid(x,x). 
waterfall(x,y,z) Same as mesh but draws mesh lines in one direction only. 

contour(x,y,z) 

[X,Y] = meshgrid(-2:0.1:2); 

Z = X.*exp(-((X-Y.^2).^2 + Y.^2)); 

subplot(2,2,1) 

mesh(X,Y,Z) 

xlabel('x') 

ylabel('y') 

zlabel('z') 

subplot(2,2,2) 

meshc(X,Y,Z) 

xlabel('x'),ylabel('y'),zlabel('z') 

subplot(2,2,3) 

meshz(X,Y,Z) 

xlabel('x'),ylabel('y'),zlabel('z') 

subplot(2,2,4) 

waterfall(X,Y,Z) 

xlabel('x'),ylabel('y'),zlabel('z') 
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12. Numerical Functions (Probability and Statistics) 
● Histograms 

MATLAB provides the mean(x) and median(x) functions to compute the average(mean) 
and the median, i.e., middle data of the array data x, respectively. The way the data are 
spread around the mean can be described by a histogram plot. To plot a histgram, you 
must group the data into subranges, called bins. 

Command Description 
bar(x,y) Creates a bar chart of y versus x. 
hist(y) Aggregates the data in the vector y into 10 bins evenly spaced 

between the minimum and maximum values in y. 
hist(y,n) Aggregates the data in the vector y into n bins evenly spaced 

between the minimum and maximum values in y. 
hist(y,x) Aggregates the data in the vector y into bins whose center locations 

are specified by the vector x. The bin widths are the distances 
between the centers. 

[z,x] = hist(y) Same as hist(y) but returns two vectors z and x that contain the 
frequency count and the bin locations. 

[z,x] = hist(y,n) Same as hist(y,n) but returns two vectors z and x that contain the 
frequency count and the bin locations. 

[z,x] = hist(y,x) Same as hist(y,x) but returns two vectors z and x that contain the 
frequency count and the bin locations. The returned vector x is the 
same as the user-supplied vector x. 

● The Data Statistics Tool 

With the Data Statistics tool you can calculate statistics for data and add plots of 
the statistics to a graph of the data. The tool is accessed from the figure window after 
you plot the data. Click on the Tools menu, then select Data Statistics. To plot the mean 
of the dependent variable (y), click the box in the row labeled mean under the column 
labeled Y. You can plot other statistics as well; these are shown in the figure. You can 
save the statistics to the workspace as a structure by clicking on the Save to Workspace 
button. This opens a dialog box that prompts you for a name for the structure 
containing the x data, and a name for the y data structure. 
 
 
 
 
 

% Hundred Rolles of Two Dice 

Sum = [2,3,4,5,6,7,8,9,10,11,12]; 

Freq = [5,5,8,11,20,10,8,12,7,10,4]; 

plot(Sum,Freq),xlabel('Sum'),ylabel('Frequency') 
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● Estimating the Mean and Standard Deviation 

MATLAB provides the following statistical functions. 
Command Description 

mean(x) Calculates the mean of the data stored in the vector x. 
median(x) Calculates the median of the data stored in the vector x. 
std(x) Calculates the standard deviation of the data stored in the vector x. 
cumsum(x) Creates a vector the same size as x, containing the cumulative sum of 

the elements of x. 
・Example 
 
 

Data Statistics 

Figure window 

Save to Workspace 

Check to plot statistics
on Figure 

Help Close 

Freq = [5,5,8,11,20,10,8,12,7,10,4], x = cumsum(Freq) 



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
110 

 
 
 
 
 

● Random Number Generation 

We often do not have a simple probability distribution to describe the distribution of 
outcomes in many engineering applications. For example, the probability that a circuit 
consisting of many components will fail is a function of the number and the age of the 
components, but we often cannot obtain a function to describe the failure probability. In 
such cases engineers often resort to simulation to make predictions. The simulation 
program is executed many times, using a random set of numbers to represent the 
failure of one or more components, and the results are used to estimate the desired 
probability. 
 Uniformly Distributed Numbers 

In a sequence of uniformly distributed random numbers, all variables within a given 
interval are equally likely to occur. The MATLAB function rand generates random 
numbers uniformly distributed over the interval [0,1]. Type rand to obtain a single 
random number in the interval [0,1]. Typing rand again generates a different number 
because the MATLAB algorithm used for the rand function requires a “state” to start. 
MATLAB obtains this state from the computer’s CPU clock. Thus every time the rand 
function is used, a different result will be obtained. 
 
 
 
 
 
 
 
Type rand(n) to obtain an n×n matrix of uniformly distributed random numbers in the 
interval [0,1]. Type rand(m,n) to obtain an m×n matrix of random numbers. Typing 
rand(size(A)) produces an array of random entries that is the same size as A. 
 
 Normally Distributed Random Numbers 

In a sequence of normally distributed random numbers, the values near the mean are 
more likely to occur. Although a uniformly distributed random variable has definite 

Freq = 

     5     5     8    11    20    10     8    12     7    10     4 

x = 

     5    10    18    29    49    59    67    79    86    96   100

EDU>> rand 

ans =  

0.6161 

EDU>> rand 

ans =  

   0.5184 
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upper and lower bounds, a normally distributed random variable does not. The 
MATLAB function randn will generate a single number that is normally distributed 
with a mean equal to 0 and a standard deviation equal to 1. Type randn(n) to obtain an 
n×n matrix of such numbers. Type randn(m,n) to obtain an m×n matrix of random 
numbers. 

Command Description 
rand Generates a single uniformly distributed random 

number between 0 and 1. 
rand(n) Generates an n × n matrix containing uniformly 

distributed random numbers between 0 and 1. 
rand(m,n) Generates an m× n matrix containing uniformly 

distributed random numbers between 0 and 1. 
s = rand(‘state’) Returns a 35-element vector s containing the current 

state of the uniformly distributed generator. 
rand(‘state’,s) Sets the state of the uniformly distributed generator to 

s. 
rand(‘state’,0) Sets the state of the uniformly distributed generator to 

its initial state. 
rand(‘state’,j) Sets the state of the uniformly distributed generator to 

state j, for integer. 
rand(‘state’,sum(100*clock)) Resets the uniformly distributed generator to a 

different state each time it is executed. 
randn Generates a single normally distributed random 

number having a mean of 0 and a standard deviation of 
1. 

randn(n) Generates an n × n matrix containing normally 
distributed random numbers having a mean of 0 and a 
standard deviation of 1. 

randn(m,n) Generates an m × n matrix containing normally 
distributed random number having a mean of 0 and a 
standard deviation of 1. 

s = randn(‘state’) Like rand(‘state’) but for the normally-distributed 
generator. 

randn(‘state’,s) Like rand(‘state’,s) but for the normally-distributed 
generator. 

randn(‘state’,0) Like rand(‘state’,0) but for the normally-distributed 
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generator. 
randn(‘state’,j) Like rand(‘state’,j) but for the normally-distributed 

generator. 
randn(‘state’,sum(100*clock)) Like rand(‘state’,sum(100*clock)) but for the 

normally-distributed generator. 
randperm(n) Generates a random permutation of the integers from 1 

to n. 
 

● Interpolation 

Engineering problems often require the analysis of data pairs. For example, the paired 
data might represent a cause and effect, or input-output relationship, such as the 
current produced in a resistor as a result of an applied voltage, or a time history, such as 
the temperature of an object as a function of time. In some applications we want to 
estimate a variable’s value between the data points. This process is called 
interpolation. In other cases we might need to estimate the variable’s value outside 
of the given data range. This process is extrapolation. 
 Linear Interpolation 

Linear interpolation in MATLAB is obtained with the interp1 and interp2 functions. 
Suppose that x is a vector containing the independent variable data and that y is a 
vector containing the dependent variable data. If x_int is a vector containing the value 
or values of the independent variable at which we wish to estimate the dependent 
variable, then typing interp1(x,y,x_int) produces a vector the same size as x_int 
containing the interpolated values of y that correspond to x_int. For example, 
 
 
 
 
 
 
 
 
 Cubic-Spline Interpolation 

Spline interpolation is widely used to fit the data points using a lower-order 
polynomial between each pair of adjacent data points. Spline interpolation obtains an 
exact fit that is also smooth. The most common procedure uses cubic polynomials, 
called cubic splines, and thus is called cubic-spline interpolation. If the data is 

EDU>> x = [7,9,11,12]; 

EDU>> y = [49,57,71,75]; 

EDU>> X_int = [8,10]; 

EDU>> Interp1(x,y,x_int) 

Ans =  

   53 

   64 
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given as n pairs of (x,y) values, then n-1 cubic polynomials are used. Each has the form 
yi(x) = a1(x Ä xi)3 + bi(x Ä xi)2 + ci(x Ä xi) + di
for xi î x î xi+1 and i = 1; 2;ÅÅÅ; n Ä 1  

The coefficients ai,bi,ci, and di for each polynomial are determined so that the following 
three conditions are satisfied for each polynomial: 
(1) The polynomial must pass through the data points at its endpoints at xi and xi+1. 
(2) The slopes of adjacent polynomials must be equal at their common data point. 
(3) The curvatures of adjacent polynomials must be equal at their common data point. 
For example, The data is given by 

x 7 9 11 12 
y 49 57 71 75 

We will shortly see how to use MATLAB to obtain these polynomials. 
・ For  7≦x≦9 

y1(x) = Ä0:35(xÄ 7)3 + 2:85(xÄ 7)2 Ä 0:3(xÄ 7) + 49 
・ For  9≦x≦11 

y2(x) = Ä0:35(xÄ 9)3 + 0:75(xÄ 9)2 + 6:9(xÄ 9) + 57 
・ For  11≦x≦12 

y3(x) = Ä0:35(xÄ 11)3 Ä 1:35(xÄ 11)2 + 5:7(xÄ 11) + 71 
MATLAB provides the spline command to obtain a cubic-spline interpolation. Its syntax 
is 
 
where x and y are vectors containing the data and x_int is a vector containing the 
values of independent variable x at which we wish to estimate the dependent variable y. 
The result y_int is a vector the same size as x_int containing the interpolated values of y 
that correspond to x_int. The spline fit can be plotted by plotting the vector x_int and 
y_int. For example, 
 
 
 
 
 
 
 
 
 
 

y_int = spline(x,y,x_int) 

x = [7,9,11,12]; 

y = [22,25,34,35]; 

x_int = [7:0.01:12]; 

y_int = spline(x,y,x_int); 

plot(x,y,'o',x,y,'--',x_int,y_int) 

xlabel('Time (hrs)') 

ylabel('Temperature (deg C)') 

title('Temperature Measurements') 

axis([7 12 20 40]) 
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Instead of plotting the cubic spline and estimating a point on the plot, we can obtain a 
more accurate calculation, more quickly, by using the following variation of the interp1 
function. 
 
In this form the function returns a column vector y_est that contains the estimated 
values of y that correspond to the x values specified in the vector x_est, using 
cubic-spline interpolation. In some applications it is helpful to know the polynomial 
coefficients, but we cannot obtain the spline coefficients from the interp1 function. 
However, we can use the form 
 
to obtain the coefficients of the cubic polynomials. The vector breaks contains the x 

values of the data, and the matrix coeffs in an m×n matrix containing the coefficients 
of the polynomials. The scalars m and n give the dimensions of the matrix coeffs; m is 
the number of polynomial, and n is the number of coefficients for each polynomial 
(MATLAB will fit a lower-order if possible, so there can be fewer than four coefficients). 
For example, 
 
 
 
 
 
 
 
 
 
 
 

Command Description 
y_int = interp1(x,y,x_int) Used to linearly interpolate a function of one 

variable: y = f(x). Returns a linearly interpolated 
vector y_int at the specified value x_int, using data 
stored in x and y. 

z_int = interp2(x,y,z,x_int,y_int) Used to linearly interpolate a function of two 
variables: z = f(x,y). Returns a linearly interpolated 
vector z_int at the specified value x_int and y_int, 

y_est = interp1(x,y,x_est,’spline’) 

[breaks, coeffs, m,n] = unmkpp(spline(x,y)) 

breaks = 

     7     9    11    12 

coeffs = 

   -0.3833    3.0500   -3.0667   22.0000 

   -0.3833    0.7500    4.5333   25.0000 

   -0.3833   -1.5500    2.9333   34.0000 

m = 

     3 

n = 

     4 

x = [7,9,11,12]; 

y = [22,25,34,35]; 

[breaks,coeffs,m,n] = unmkpp(spline(x,y)) 
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using data stored in x,y, and z. 
y_est=interp1(x,y,x_est,’spline’) Returns a column vector y_est that contains the 

estimated values of y that correspond to the x values 
specified in the vector x_est, using cubic-spline 
interpolation. 

y_int=spline(x,y,x_int) Computes a cubic-spline interpolation where x and y 
are vectors containing the data and x_int is a vector 
containing the values of the independent variable x 
at which we wish to estimate the dependent variable 
y. The result y_int is a vector the same size as x_int 
containing the interpolated values of y that 
correspond to x_int. 

[greaks,coeffs,m,n]= 

unmkpp(spline(x,y)) 

Computes the coefficient of the cubic-spline 
polynomials for the data in x and y. The vector 
breaks contains the x values, and the matrix coeffs 
is an m×n matrix containing the coefficients of the 
polynomials. The scalar m and n give the dimensions 
of the matrix coeffs; m is the number of polynomials, 
and n is the number of coefficients for each 
polynomial. 
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13. Numerical Functions (Integration and Differentiation) 
● Integration 

 

 

 

 

 

 

 

 

The simplest way to find the area under a curve is to split the area into rectangular. 
A more sophisticated method is to use trapezoidal elements. Each trapezoid is called 
a panel. It is not necessary to use panels of the same width; to increase the method’s 
accuracy you can use narrow panels where the function is changing rapidly. When the 
widths are adjusted according to the function7s behavior, the method is said to be 
adaptive. MATLAB implements trapezoidal integration with the trapz function. Its 
syntax is 
  
where the array y contains the function values at the points contained in the array x. If 
you want the integral of a single function, then y is a vector. To integrate more than one 
function, place their values in a matrix y; typing trapz(x,y) will compute the integral of 
each column of y.  
・Example 

 

 

 

 

 

 

 

 

 

 

 

You cannot directly specify a function to integrate with the trapz function. The quad and 
quad1 functions can accept functions directly, e.g., y = quad(‘sin’,0,pi). 

Rectangular 
Trapezoidal 

trapz(x,y) 

for  k = 1:5 

  x = linspace(0,pi,k*10); 

  y = sin(x); 

  z = trapz(x,y) 

end 

z = 

    1.9797 

z = 

    1.9954 

z = 

    1.9980 

z = 

    1.9989 

z = 

    1.9993 
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Command Description 
quad(‘function’,a,b,tol) Uses an adaptive Simpson’s rule to compute the integral of 

the function ‘function’ with a as the lower integration limit 
and b as the upper limit. The parameter tol is optional. tol 
indicates the specified error tolerance. 

quad1(‘function’,a,b,tol) Uses Lobatto quadrature to compute the integral of the 
function ‘function’. The rest of the syntax is identical to 
quad. 

trapz(x,y) Uses trapezoidal integration to compute the integral of y 
contains the function values at the points contained in the 
array x. 

●Differentiation 

MATLAB provides the diff function to use for computing derivative estimates. Its 
syntax is 
 
Where x is a vector of values, and the result is a vector d containing the differences 
between adjacent elements in x. That is, if x has n elements, d will have n-1 elements, 
where d =[x(2)-x(1),x(3)-x(2),…,x(n)-x(n-1)]. For example, if x = [5,7,12], then diff(x) 
returns the vector [2,5]. 
・Example 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

d = diff(x) 

%comparisons of numerical derivative  

%algorithms in the case f(x) = sin(x) 

x = [0:pi/50:pi]; 

n = length(x); 

% true derivative 

td =cos(x); 

% generating function with +/-0.025 random error.

y = sin(x) + 0.05*(rand(1,51)-0.5) ; 

% backward difference 

d1 = diff(y)./diff(x); 

subplot(2,1,1) 

plot(x(2:n),td(2:n),x(2:n),d1,'o') 

xlabel('x'),ylabel('Derivative') 

axis([0 pi -2 2]) 

gtext('Backward Difference Estimate') 

% central difference 

d2 = (y(3:n)-y(1:n-2))./(x(3:n)-x(1:n-2)); 

subplot(2,1,2) 

plot(x(2:n-1),td(2:n-1),x(2:n-1),d2,'o') 

xlabel('x'),ylabel('Derivative') 

axis([0 pi -2 2]) 

gtext('Central Difference Estimate') 
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● Polynomial Derivatives 

MATLAB provides the polyder function to compute the derivative of a polynomial. The 
derivative of  

f(x) = a1xn + a2xnÄ1 +ÅÅÅ+ anÄ1x+ an 

is 
df(x)

dx
= na1x

nÄ1 + (nÄ 1)a2xnÄ2 +ÅÅÅ+ anÄ1
= b1x

nÄ1 + b2xnÄ2 +ÅÅÅ+ bnÄ1  
 
Because polynomial derivatives can be obtained from the preceding formula, the 
polyder function is technically not a numerical differentiation operation. Its syntax is 
 
 
where p is a vector whose elements are the coefficients of the polynomial arranged in 
descending powers; that is, p = [a1,a2,…,an]. The output is the vector b containing the 
coefficients of the derivative; that is, b = [b1,b2,…,bn-1]. The second syntax is 
 
 
This form computes the derivative of the product of the two polynomials p1 and p2. The 
third syntax is  
 
 

b = polyder(p) 

p = polyder(p1,p2) 

[num,den] = polyder(p2,p1) 
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This form computes the derivative of the quotient p2/p1. The vector of coefficients of the 
numerator of the derivative is given by num. The denominator is given by den. 

Command Description 
d = diff(x) Returns a vector d containing the differences between 

adjacent elements in the vector x. 
b = polyder(p) Returns a vector b containing the coefficients of the 

derivative of the polynomial represented by the vector p. 
b = polyder(p1,p2) Returns a vector b containing the coefficients of the 

polynomial that is the derivative of the product of the 
polynomials represented by p1 and p2. 

[num,den] = polyder(p2,p1) Returns the vectors num and den containing the 
coefficients of the numerator and denominator 
polynomials of the derivative of the quotient p2/p1,where 
p1 and p2 are polynomials. 

 

14. Numerical Functions (Nonlinear Equations and Optimization) 
● Finding the Zeros of a Function 

The root function finds the zeros of polynomial functions only, e.g., 
 
 
 
 
 
 
 
 
 
Otherwise, you can use the fzero function to find the zero of a function of a single 
variable, which is denoted by x. One form of its syntax is  
 
 
where function is a string containing the name of the function, and x0 is a user-supplied 
guess for the zero. The fzero function returns a value of x that is near x0. For example, 
 
 
 

EDU>> p = [1 2 2 2 1 5]; 

EDU>> roots(p) 

ans = 

  -1.8060           

  -0.7243 + 1.3022i 

  -0.7243 - 1.3022i 

   0.6273 + 0.9238i 
   0.6273 - 0.9238i 

fzero(‘function’,x0) 

function y = ex_defnleq(x) 

y = sin(x)-cos(x); 
Save the function M-file
named ex_defnleq.m 
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The alternative syntax [x,fval] = fzero(‘function’,x0) returns the value of function at the 
solution x. The syntax [x,fval,exitflag] = fzero(‘function’,x0) returns a value of exitflag 

that describes the exit condition of fzero. 
● Minimizing a Function of One Variable 

The fminbnd function finds the minimum of a function of a single variable, which is 
denoted by x. One form of its syntax is fminbnd(’function’,x1,x2), where function is a 
string containing the name of the function. The fminbnd function returns a value of x 
that minimizes the function in the interval x1≦x≦x2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The alternative syntax [x,fval] = fminbnd(‘function’,x1,x2) returns the value of function 
at the solution x. The syntax [x,fval,exitflag] = fminbnd(‘function’,x1,x2) returns a 
value of exitflag, which describes the exit condition of fminbnd. 
● Minimizing a Function of Several Variables 

To find the minimum of a function of more than one variable, use the fminsearch 
function. One form of its syntax is fminsearch(‘function’,x0), where function is a string 
containing the name of the function. The vector x0 is a guess that must be supplied by 
the user. 
 
 
 

Execute the fzero function in
the command window 

>> fzero('ex_defnleq',2) 

ans = 

    0.7854 

Save as defnleq2.m 

----------- 

function y = ex_defnleq2(x) 

y = 1-x.*exp(-x); 

Save as example_fminbnd.m 

----------- 

[x,fv] = fminbnd('ex_defnleq2',0,5) 

 xrange = [0:0.01:5]; 

 y = 1-xrange.*exp(-xrange); 

 plot(xrange,y) 

 text(x,fv,'o') 

Save as defnleq3.m 

function y = ex_defnleq2(x) 

y = 1-x.*exp(-x); 
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Function Description 
fminbnd(‘function’,x1,x2) Returns a value of x in the interval x1≦ x≦ x2 that 

corresponds to a minimum of the single-variable function 
described by the string ‘function’. 

fminsearch(‘function’,x0) Uses the starting vector x0 to find a minimum of the 
multivariable function described by the string ‘function’. 

fzero(‘function’,x0) Uses the starting vector x0 to find a zero of the single- 
variable function described by the string ‘function’. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Save as example_fminsearch.m 

[x,fv] = fminsearch('ex_defnleq3',[0,0]) 

[X,Y] = meshgrid(-2:0.1:2); 

Z = X.*exp(-X.^2 - Y.^2); 

mesh(X,Y,Z) 

text(x(1),x(2),fv,'o') 
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15. Numerical Functions (Differential Equations) 
● The Euler Method 

The Euler method is the simplest algorithm for numerical solution of a differential 
equation. It usually gives the least accurate results but provides a basis for 
understanding more sophisticated methods. Consider the equation 

dy
dt = f(t; y) 

where f(t,y) is a known function. If the time increment Δt  is small enough, the 
derivative can be replaced by the approximation expression 

dy
dt ô y(t+Å t)Äy(t)

Å t  

Use the above equation to replace the differential equation, we have 
y(t+Åt) = y(t) + f(t; y(t))Åt 

Assume that the term r(t)y remains constant over the time interval (t,t+Δt). Then the 
above equation can be written in more convenient form as follows: 

y(tk+1) = y(tk) + f(tk; y(tk))Åt 
where tk+1 = tk +Åt . This technique for replacing a differential equation with a 
difference equation is the Euler method. The incrementΔt is called the step size. 
This equation can be applied successively at the times tk by putting it in a for loop. For 
example,  

èDiãerential equation _y = Ä10y

è Initial condition y(0) = 2

è Step size Åt = 0:02

è Plot the solution over the range 0 î t î 0:5 
 
 
 
 
 
 
 
 
 
 
 

r = -10; delta = 0.02 

y(1) = 2; k=0; 

for time = [delta:delta:0.5] 

     k = k + 1; 

     y(k+1) = y(k) + r*y(k)*delta; 

end 

t = [0:delta:0.5]; y_true = 2*exp(-10*t); 

plot(t,y,'o',t,y_true) 

xlabel('t'), ylabel('y') 
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The accuracy of the Euler method can be improved by using a smaller step size. 
However, very small step sizes require longer run times and can result in a large 
accumulated error because of round-off effects. 
● The Predictor-Corrector Method (The Modified Euler Method) 

Consider the first-order differential equation same as in the Euler method. Suppose 
instead we use the average of the right side of the differential equation on the interval 
(tk,tk+1). This gives 

y(tk+1) = y(tk) +
Åt
2 (fk + fk+1) where fk = f(tk; y(tk)) 

The difficulty with the above equation is that fk+1 cannot be evaluated until y(tk+1) is 
known, but this is precisely the quantity being sought. A way out of this difficulty is by 
using the Euler formula to obtain a preliminary estimate of y(tk+1). We obtain the 
following predictor-corrector processes: 

è Step size : h = Åt

è Euler predictor : xk+1 = yk + hf(tk; yk)

èTrapezoidal corrector : yk+1 = yk + h
2 [f(tk; yk) + f(tk+1; xk+1)] 

・Example  
 
 
 
 
 
 
 
 
 
 
 
 
The error is less than with the Euler method, but there is still some noticeable error if 
the solution of a differential equation is rapidly changing. 
● Runge-Kutta Methods 

The Taylor series representation forms the basis of several methods for solving 
differential equations, including the Runge-Kutta methods. For example, a 

r = -10; delta = 0.02 

y(1) = 2; k=0; 

for time = [delta:delta:0.5] 

  k = k + 1; 

  x(k+1) = y(k) + delta*r*y(k); 

  y(k+1) = y(k) + (delta/2)*(r*y(k)+r*x(k+1));

end 

t = [0:delta:0.5]; 

y_true = 2*exp(-10*t); 

plot(t,y,'o',t,y_true) 

xlabel('t'), ylabel('y') 
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fourth-order Runge-Kutta algorithm duplicates the Taylor series through the 
fourth-oder term. 
・ The second-order Runge-Kutta method 

g1 = hf(tk; yk)

g2 = hf(tk +ãh; yk +åhfk)

yk+1 = yk + w1g1 + w2g2

where w1; w2;ã, and åmust be selected such as

w1 + w2 = 1; w1ã= w2å= 0:5  

・ The fourth-order Runge-Kutta method 

g1 = hf(tk; yk)

g2 = hf(tk +ã1h; yk +ã1g1)

g3 = hf(tk +ã2h; yk +å2g2 + (ã2 Äå2)g1)
g4 = hf(tk +ã3h; yk +å3g2 +ç3g3 + (ã3 Äå3 Äç3)g1)

yk+1 = yk + w1g1 + w2g2 + w3g3 +w4g4

where w1; w2; w3; w4;ã1; ã2; å2;ã3; å3, and ç3 must be selected such as

w1 = w4 =
1

6
; w2 = w3 =

1

3

ã1 = ã2 = å2 =
1

2
ã3 = ç3 = 1;å3 = 0  

● MATLAB ODE Solvers 

In addition to the many variations of the predictor-corrector and Runge-Kutta 
algorithms that have been developed, some more advanced algorithms use a variable 
step-size. These algorithms use larger step sizes when the solution is changing more 
slowly. MATLAB provides functions, called solver, that implement ode23, ode45, and 
ode113 functions. The ode23 function uses a combination of second- and third-order 
Runge-Kutta methods, whereas ode45 uses a combination of fourth- and fifth-order 
methods. The solver ode113 is based on a variable-order algorithm. MATLAB contains 
four additional solvers; these are ode23t, ode15s, ode23s, and ode23tb. A stiff 
solver is one that is well-suited for solving stiff equations. A stiff differential 
equation is one whose response changes rapidly over a time scale that is short 
compared to the time scale over which we are interested in the solution, e.g., 

°y + 1001 _y + 1000y = 0 
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Solver name Description 
ode23 

ode45 

ode113 

ode23s 

ode23t 

ode23tb 

ode15s 

Nonstiff, low-order solver. 
Nonstiff, medium-order solver. 
Nonstiff, variable-order solver. 
Stiff, low-order solver. 
Moderately stiff, trapezoidal-rule solver. 
Stiff, low-order solver. 
Stiff, variable-order solver. 

 
Command Description 

[t,y] = ode23(‘ydot’,tspan,y0) 

or 

[t,y] = ode23(@ydot,tspan,y0) 

Solves the vector differential equation ),( ytfy =&  
specified in the function M-file ydot.m, whose inputs 
must be t and y and whose output must be a column 
vector representing dtdy ; that is ),( ytf . The 
number of rows in this column vector must equal the 
order of the equation. The vector tspan contains the 
starting and ending values of the independent variable 
t, and optionally, any intermediate values of t where 
the solution is desired. The vector y0 contains the 
initial value of y. The function M-file must have two 
input arguments t and y even for equations where 

),( ytf  is not a function of t. The syntax is identical 

for the other solvers. 
 
For example, consider the equation 

dy

dt
= sin t; y(0) = 0

analytical solution:y(t) = 1Ä cos t 
To use MATLAB ode solvers, you must create two files; a script and a function M-files. 
 Function M-file for defining the differential equation 
 
 
 
 
 

 

function ydot = sinefn(t,y) 

ydot = sin(t); 
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● Examples 

 Nonlinear Pendulum Model 

The pendulum shown the figure consists of a concentrated mass m attached to a rod 
whose mass is small compared to m. The rod’s length is L. The equation of motion for 
this pendulum is 

d2í
dt2 +

g
L siní= 0  

 
 
 
 
 
 
 
 
 
 
 
 

t_true = [0:0.01:4*pi]; 

[t,y] = ode45(@sinefn,[0,4*pi],0); 

y1_true = 1-cos(t_true); 

subplot(2,1,1) 

plot(t,y,'o',t_true,y1_true) 

xlabel('t'),ylabel('y') 

axis([0 4*pi -0.5 2.5]) 

gtext('ode45') 

[t,y] = ode23(@sinefn,[0,4*pi],0); 

y2_true = 1-cos(t_true); 

subplot(2,1,2) 

plot(t,y,'o',t_true,y2_true) 

xlabel('t'),ylabel('y') 

axis([0 4*pi -0.5 2.5]) 

gtext('ode23') 

θ  

m

L  

mg  



* MATLAB and SIMULINK are registered trademarks of The MathWorks, Inc. 
http://www.mathworks.com/ 

KITA text, 12/18-20/2002 
127 

Suppose that L=1 meter and g=9.81 meters/second2. Use MATLAB to solve this 
equation for θ(t) for two cases: θ(0)=0.5 radian andθ(0)=0.8π radians. In both cases 

0)0( =θ& . 
 
First rewrite the pendulum equation as two first-order equations. Letting 

x1 = í; x2 = _í 

we have 

_x1 = _í= x2

_x2 = °í= Ä g
L
sinx1

 
The function M-file for defining the differential equation is as follows: 
 
 
 
 
It is called as follows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

function xdot = pendulum(t,x) 

global g L 

xdot = [x(2); -(g/L)*sin(x(1))]; 

global g  L 

g = 9.81; L = 1; 

[ta,xa] = ode45(@pendulum,[0,5],[0.5,0]); 

[tb,xb] = ode45(@pendulum,[0,5],[0.8*pi,0]); 

subplot(2,1,1) 

plot(ta,xa(:,1),tb,xb(:,1)) 

xlabel('Time (sec)'),ylabel('Angle (rad)') 

gtext('Case 1'),gtext('Case 2') 

subplot(2,1,2) 

plot(ta,xa(:,2),tb,xb(:,2)) 

xlabel('Time (sec)'),ylabel('Angular velocity (rad/sec)') 

gtext('Case 1'),gtext('Case 2') 
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 Mass-Spring Model 

 

 

 

 

 

 

 

 

 

The dynamic equation of the mass and spring model is given by 

md2y(t)
dt2 + cdy(t)dt + ky(t) = f(t) 

This equation can be put into Cauchy form by letting  

x1 = y; x2 =
dy(t)
dt , 

which gives 

_x1 = x2

_x2 = Ä k
m
x1 Ä c

m
x2 +

1

m
f(t)

 

These two equations can be written by a state-space equation as follows: 

Mass:m 

Displacement 
y(t) 

Driving force 
f(t) 

Spring constant 
k 

Damping coefficient:c 
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dx(t)

dt
= Ax(t) +Bf(t)

y(t) = Cx(t)

x(t) =

"
x1(t)

x2(t)

#
A =

"
0 1

Ä k
m Ä c

m

#
; B =

"
0
1
m

#
; C =

h
1 0

i
 

The following M-files show how to use matrix operations in the state space equation. In 
this example m=1, c=2, k=5, and the applied force f is a constant equal to 1. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

Save as msd.m 

function xdot = msd(t,x) 

global c f k m 

A = [0, 1; -k/m, -c/m]; 

B = [0; 1/m]; 

xdot = A*x + B*f; 

Save as example_massspring.m 

global c f k m 

m = 1; c = 2; k = 5; 

f = 1; 

[t,x] = ode23(@msd,[0,5],[0,0]); 

plot(t,x) 

xlabel('Time (sec)') 

ylabel('Displacement (m) and Velocity (m/sec)') 

gtext('Displacement') 

gtext('Velocity') 
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● ODE Solvers in the Control System Toolbox 

Many of the function of the Control System toolbox can be used to solve linear, 
time-invariant (constant-coefficient) differential equations. They are sometimes more 
convenient to use and more powerful than the ODE solvers discussed thus far, because 
general solutions can be found for linear, time invariant equations. 
 Model Forms 

The ODE solvers in the Control System toolbox can accept various descriptions of the 
equations to be solved. Version 4 of the Control Systems toolbox introduces the LTI 
object, which describes a linear, time-invariant equation, or sets of equations, here 
referred to as the system. An LTI object can be created from differential descriptions of 
the system; it can be analyzed with several functions; and it can be accessed to provide 
alternative descriptions of the system. For example, the equation 

2°y + 3 _y +5y = u(t) 

is one description of a particular system. This description is called the reduced form. 
Using Laplace transform, we have the following an input-output relation. 

G(s) =
Y (s)

U(s)
=

1

2s2 + 3s+ 5

where

Y (s) = Lfy(t)g; U(s) = Lfu(t)g 
G(s) is called the transfer function. 
The following is the state-space model description of the same system: 

dx

dt
= Ax+ Bu

where x1 = y; x2 = _y, and

A =

"
0 1

Ä5
2 Ä3

2

#
; B =

"
0
1
2

#
; x =

"
x1

x2

#
 

Because there are two or more state variables in a state-space model, we need to be able 
to specify which state variables, or combination of variables, constitutes the output of 
the model. This specification of the output, denoted by the vector y, is done in general 
with the matrices C and D, which are defined as follows: 

y =Cx+Du 
This equation is called the output equation. In this case, we have the following 
output equation: 
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y =
h
1 0

i
x

 

・ How to create an LTI object using the transfer function model 

 
 
・ How to create an LTI object using the state-space model 

 
 
 
 
 
 
・ How to get a transfer function model from the LTI object 

 
 

where num:numerator of transfer function 
den:denominator of transfer function.  

・ How to get a state-space model from the LTI object 

 
 
 ODE Solvers 

The Control System toolbox provides several solvers for linear model. These solvers are 
categorized by the type of input function they can accept; zero input, impulse input, step 
input, and a general input function. For example, 
 
 
 
 
 
 
 
 
 
 
 

 

sys1 = tf(1,[2, 3, 5]) 

A = [0, 1; -5/2, -3/2]; 

B = [0; -1/2]; 

C = [1, 0]; 

D = 0; 

sys2 = ss(A,B,C,D) 

[num,den] = tfdata(sys1) 

[A,B,C,D] = ssdata(sys2) 

A1 = [0,1; -5/2, -3/2]; B1 = [0;1/2]; 

C1 = [1,0]; D1 = 0; 

sys11 = ss(A1,B1,C1,D1); 

A2 = [0,1; -10/2, -30/2]; B2 = [0;1/2]; 

C2 = [1,0]; D2 = 0; 

x0 = [2, -2]; 

tint = [0:0.01:10]; 

sys12 = ss(A2,B2,C2,D2); 

initial(sys11,'r',sys12,'b--',x0,tint) 
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Command Description 
impulse(sys) Computes and plots the unit-impulse response of the LTI object sys. 
initial(sys,x0) Computes and plots the free response of the LTI object sys given in the 

state-space model form, for the initial conditions specified by the vector 
x0. 

lsim(sys,u,t) Computes and plots the response of the LTI object sys to the input 
specified by the vector u, at the times specified by the vector t. 

step(sys) Computes and plots the unit-step response of the LTI object sys. 
 

sys21 = tf(1,[2, 3, 5]); 

sys22 = tf(1,[2, 15, 5]); 

tint = [0:0.01:10]; 

impulse(sys21,'r',sys22,'b--',tint) 

pause 

step(sys21,'r',sys22,'b--',tint) 

sys21 = tf(1,[2, 3, 5]); 

sys22 = tf(1,[2, 15, 5]); 

tint = [0:0.01:10]; 

x0 = [2, -2]; 

u = sin(tint); 

lsim(sys21,'r',sys22,'b--',u,tint,x0) 
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 Predefined Input Functions 

You can always create any complicated input function to use with the ODE solvers by 
defining a vector containing the input function’s values at specified times. However, 
MATLAB provides several predefined functions that you might find easier to use. For 
example, 
 
 
 
 
 
 
 
 

Command Description 
[u,t] = gensig(type,period,tf,dt) Generates a periodic input of a specified type type, 

having a period period. The following types are 
available: sine wave (type=’sin’), square wave 
(type=’square’), and narrow-width periodic pulse 
(type=’pulse’). The vector t contains the times, and 
the vector u contains the input values at those times. 
All generated inputs have unit amplitudes. The 
optional parameters tf and dt specify the time 
duration tf of the input and the spacing dt between 
the time instants. 

sawtooth(t,width) Returns a vector the same length as t corresponding 
to a sawtooth wave of period 2 π. The optional 
parameter width generates a modified sawtooth wave 
where width determines the fraction between 0 and 2
π at which the maximum occurs (0≦width≦1). 

square(t,duty) Returns a vector the same length as t corresponding 
to a square wave of period 2 π. The optional 
parameter duty generates a square wave with a duty 
cycle specified by duty, which is the percentage of the 
period over which the function is positive. 

stepfun(t,t0) Returns a vector the same length as t with zeros 
where t<t0 and ones where t≧t0.  

sys5 = tf(4,[1,2,4]); 

[u,t] = gensig('square',5,10,0.01); 

[y,t] = lsim(sys5,u,t); 

plot(t,y,t,u) 

axis([0 10 -0.5 1.5]) 

xlabel('Time') 

ylabel('Response') 
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16. An Overview of SIMULINK  
SIMULINK is an extension of MATLAB that is used to simulate dynamic systems. 
SIMULINK differs from MATLAB in that it has a window-based (using block diagram) 
graphical user interface. It also adds much functionality to MATLAB. We will describe 
the basic concepts and some of the commands you will be using to simulate dynamic 
systems. It provides a graphical user interface that uses various types of differential or 
difference equations whose independent variable is time. For example, one block type is 
a multiplier, another performs a sum, and another is an integrator. The interface 
enables you to position the blocks, resize them, label them, specify block parameters, 
and interconnect the blocks to describe complicated systems for simulation. 
● Start SIMULINK 

Type simulink in MATLAB Command window or click the icon on the toolbar to start 
SIMULINK. The SIMULINK Library Browser window opens. 
 
 
 
 
 
 
 
 
 
 
● Open the Window to Create Your Model 

To create a new model, click on the icon that resembles a clean sheet of paper, or select 

New from the File menu in the Browser. A new Untitled window opens for you to create 
the model. 
● Create Your Model 

To select a block from the Library Browser, double-click on the appropriate library 
category, and a list of blocks within that category then appears. Click on the block name 
or icon, hold the mouse button down, drag the block to the new model window, and 
release the button. Note that when you click on the block name in the Library Browser, 
a brief description of the block’s function appears at the top of the Browser. You can 
access help for that block by right-clicking on its name or icon, and selecting Help from 
the drop-down menu. 
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Descrete time systems 

File Edit View Help 

If you click on the Simulink icon, these are same.

Additional Simulink Blocksets 

Continuous time systems 

User-defined functios or tables 

Mathemtical operators and

exp,sin functions 
Nonlinear functions such as backlash,

saturation etc. 

Assigment inport and outport ets.

Display output waves. 

Signal generators 

Click Continuos icon 
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Click Descrete icon 

Click Functions & Tables icon
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Click Math icon 

Click Nonlinear icon 
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Click Signals & Systems icon

Click Sinks icon 
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● Draw Your Model via Block Diagram 

You can create a model by drawing its block diagram like other drawing software. 
● Access SIMULINK files 

SIMULINK model files have the extension .mdl. Use the File menu in the model 
window to Open, Close, and Save model files. To print the block diagram of the model, 
select Print on the File menu. Use the Edit menu to copy, cut and paste blocks. You can 
also use the mouse for these operations. For example, to delete a block, click on it and 
press the Delete key. 

Click Sources icon 
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● Simulating Transfer Function Models 

Consider the following transfer function with the dead zone 

Y (s) =
1

s2 + 2s + 4
Z(U (s))

Z(Å) : dead zone; u(t) = sin 1:5t  
To construct the simulation, do the following steps. 
(1) Start SIMULINK and open a new model window as described previously. 
 
 
 
 
 
 
 
(2) Select and place in the new window the Sine block form the Sources category. 

Double-click on it, and set the Amplitude to 1, the Frequency to 1.5 the Phase to 
0, and the Sample time to 0. Click Apply, then OK. 
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(3) Select and place the Dead Zone block from the Nonlinear category, 
double-click on it, and set the Start of dead zone to –0.5 and the End of dead 
zone to 0.5. Click Apply, then OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(4) Select and place the Transfer Fcn block from the Continuous category, 

double-click on it, and set the Numerator to [1] and the Denominator to [1,2,4]. 
Click Apply, then OK. 
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(5) Select and place the Scope block from the Sinks category. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
(6) Once the blocks have been placed, connect the input port on each block to the output 

port on the preceding block. To do this, move the cursor to an input port or an output 
port; the cursor will change to a cross. Hold the mouse button down, and drag the 
cursor to a port on another block. When you release the mouse button, SIMULINK 
will connect them with an arrow pointing at the input port. 
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(7) Click on the Simulation menu, and click the Simulation Parameters item. Click 
on the Solver tab, and enter 10 for the Stop time. Make sure the Start time is 0. 
Then click OK. 

 
(8) Run the simulation by clicking on the Simulation menu, and then clicking the 

Start item. You can also start the simulation by clicking on the Start icon on the 
toolbar. 

 
 
 
 
 
 
 
 
 
 
 
 
(9) You will hear a bell sound when the simulation is finished. Then double-click on 

the Scope block on the binoculars icon in the Scope display to enable autoscaling. 
You should see an oscilationg curve. The independent variable in the Scope block is 
time; the input to the block is the dependent variable. This completes the 
simulation. 
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(10) To save the SIMULINK file, select Save As … in the File menu. 

 
It is informative to plot both the input and the output of the Transfer Fcn block versus 
time on the same graph. To do this, 
(1) Delete the arrow connecting the Scope block to the Transfer Fcn block. Do this by 

clicking on the arrow line and then pressing the Delete key. 
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(2) Select and place the Mux block from the Signal & Systems category, 
double-click on it, and set the Number of input to 2. Click Apply, then OK. 

 
 

(3) Connect the top input port of the Mux block to the output port of the Transfer Fcn 
block. Then use the same technique to connect the bottom input port of the Mux 
block to the arrow from the output port of the Dead Zone block. 

 
 
 
 
 
 
 
 
 
(4) Set the Stop time to 10, run the simulation as before, and bring up the Scope 

display. 
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You can bring the simulation results into the MATLAB workspace by using the Scope 
block. For example, suppose we want to examine the effects of the dead zone by 
comparing the response of the system with and without a dead zone. To create this 
model, 
(1) Copy the Transfer Fcn block by right-clicking on it, holding down the mouse button, 

and dragging the block copy to a new location. Then release the button.  
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(2) Connect the copied Transfer fcn block as in the following window: 
 
 
 
 
 
 
 
 
 
 
 
(3) Click the property icon in the Scope Graph window.  
 

 
 
 
 
 
 
 
 
 
Select the Data history tab, check the box at Save data to workspace, assigning 
the Variable name as you like and the Format as Structure with time. 

 
 
 
 
 
 
 
 
 
 
 

Save the data named Outputdata
to workspace 
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(4) After running the simulation, type the following commands in the Command 
window to check the data named Outputdata is saved or not. 

 
 
 
 
 
  
 
 
 
 
 
 
 
 
(5) You can plot the responses by executing the following script M-file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

>> Outputdata 

Outputdata =  

         time: [65x1 double] 

      signals: [1x1 struct] 

    blockName: 'intro3/Scope' 

>> Outputdata.signals 

ans =  

        values: [65x3 double] 

    dimensions: 3 

         label: '' 

         title: '' 

     plotStyle: [0 0 0] 

Outputdata is a structure array. 
Structure elements 
・Outputdata.time 
・Outputdata.signals 

Outputdata.signals.values 

Outputdata.signals.dimensions 

Outputdata.signals.label 

Outputdata.signals.title 

Outputdata.signals.plotStyle 
・Outputdata.blockName 

plot(Outputdata.time,Outputdata.signals.values) 

xlabel('Time'),ylabel('Responses') 
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● Simulating Integrator Model 

Consider the equation 
°y + 2 _y + 4y = u 

Defining the variables as 
x1 = y; x2 = _y; x3 = °y  

we have the following algebraic equation: 
x3 = Ä4x1 Ä 2x2 + u  

Integration gives the following equations: 

y(t) = x1(t)

x1(t)Ä x1(0) =

Z t

0

x2(t)dt

x2(t)Ä x2(0) =

Z t

0

x3(t)dt
 

The flow of creating SIMULINK is as follows: 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

Integrator 
Continuous 
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Math Gain 

Double-click 

Math 

Double-click 
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Double-click 

Set the initial value 
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● Simulating State-Space Models 

The equation of motion for the mass and spring with viscous surface friction is shown 
the following figure. 
 

 

 

 

 

 

 

 

The dynamic equation of the mass and spring model is given by 

md2y(t)
dt2 + cdy(t)dt + ky(t) = f(t) 

This equation can be put into Cauchy form by letting  

x1 = y; x2 =
dy(t)
dt , 

which gives 

_x1 = x2

_x2 = Ä k
m
x1 Ä c

m
x2 +

1

m
f(t)

 

These two equations can be written by a state-space equation as follows: 
dx(t)

dt
= Ax(t) +Bf(t)

y(t) = Cx(t)

x(t) =

"
x1(t)

x2(t)

#
A =

"
0 1

Ä k
m Ä c

m

#
; B =

"
0
1
m

#
; C =

h
1 0

i
 

 
 
 
 
 
 

Mass:m 

Displacement 
y(t) 

Driving force 
f(t) 

Spring constant 
k 

Damping coefficient:c 
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Continuous State-Space 

Double-click and set A,B,C, and 
D and initial condition x(0) 
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● Linearization Function 

Consider the following nonlinear system: 

dx

dt
= f(x; u; t)

y = g(x; u; t)  
The above nonlinear system can be linearized about an equilibrium point (x*,u*). Let us 
define the perturbed states and control inputs by 

éx = x Ä xÉ; éu = u Ä uÉ 
Then first-order approximation, using Taylor’s series expansion, the linearized 
equations are given by 

déx

dt
= Aéx+Béu

y = Céx+Déu

A =
@f

@x
;B =

@f

@u
;C =

@g

@x
;D =

@g

@u 
This linear state-space equation is called a linearlized system of the nonlinear 
system. The linmod command is used to obtain the state space representation of 
linearized systems. Its syntax is  
 
 
 
The ‘model’ is the name of the SIMULINK-generated block diagram model. In the 
second syntax form, the equilibrium points for the states and control inputs can be 
specified. We must assign the inputs and outputs of the system using the In and Out 

block from the Signal & Systems category. 
 
 
 

m = 1; c = 2; k = 5; 

A = [0, 1; -k/m, -c/m]; 

B = [0; 1/m]; 

C = [1, 0]; 

D = 0; 

After executing the following script M-file, run the SIMULINK file. 

Save the parameters to the
Workspace. 

[a,b,c,d] = linmod(‘model’); 

[a,b,c,d] = linmod(‘model’,x,u); 
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Signals&Systems 

In 

Signals&Systems 
Out 
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● Example (A Chaotic System: The Lorenz system) 

The Lorenz system is a set of three first-order nonlinear differential equations. They 
were first presented in 1963 by E.N. Lorenz, whose motivation for the problem was 
weather forecasting. The equations are given below: 

_x = a(y Ä x)
_y = x(bÄ z)Ä y
_z = cz + xy  

Lorenz realized the exponential divergence of nearby initial conditions and concluded 
that the fundamental problem of long-term weather forecasting is imprecise knowledge 
of initial conditions. The strong dependence of solutions of nonlinear dynamic systems 
on their initial condition has been long recognized. The term chaos commonly refers to 
the fact that it is impossible to exactly predict the behavior of nonlinear systems in the 
long run, even though the underlying phenomenon is deterministic and represented by 
a simple set of differential equations. The simulation parameters are 

a = 10; b = 28; c = Ä8=3; x(0) = y(0) = z(0) = 5 
 
 
 
 

Save the SIMULINK file named example_linmod.mdl and execute
the linmod command in the Comannd window. 
 
>> [A,B,C,D] = linmod('example_linmod') 

A = 

         0    1.0000 

   -4.0000   -2.0000 

B = 

         0 

    1.0000 

C = 

    1.0000         0 

D = 

     0 
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Set the initial conditions 
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17. Applications of MATLAB/SIMULINK to Engineering Problems 
● Control Systems Analysis/synthesis 

● Signal Processing 

● Image Processing 

 

18. Symbolic Processing with MATLAB 
Up to now we have used MATLAB to perform numerical operations only; that is, our 
answers have been numbers, not expressions. MATLAB also can perform operations 
such as addition and multiplication on mathematical expression, and symbolic 
differentiation and integration. The symbolic processing capabilities in MATLAB are 
based on the Maple V software package, which was developed by Waterloo Maple 
Software, Inc. The MathWorks has licensed the Maple “engine”, that is the core of 
Maple. We omit the details. 
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